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Preface 
 
This document contains information about the Wavewin Comtrade data management, and analysis 
system for Windows 98 and above. 
 
The management capabilities (File Manager) provide tools for copying, moving, deleting, renaming, 
sorting, and searching event files.  The analysis feature (Data Display) is used to view and manipulate 
waveform and load files.  Displayed channels can be marked, moved, zoomed, removed, restored, 
superimposed, scaled, numerically processed, and/or summarized.  It also offers extra software channels 
that provide engineers with a generic tool for monitoring and/or molding tasks. 

Documentation Format 

The documentation is structured to the following format: 
 
Chapter 1: describes the main features of the File Manager, and Data Display. 
 
Chapter 2: describes the system requirements and the installation procedure. 
 
Chapter 3: lists the fields and features in the system. 
 
Appendix A: defines the scripting language used to create format files for the Save Sample Values 

feature. 
 
Appendix B: describes the system errors that might be encountered while working with the software. 
 
Appendix C: lists the available function keys, navigational keys, and menu buttons for the file table, the 

query fields, the data display, and the DXF display. 
 
Appendix D: lists the abbreviations and symbols used by the system. 
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C H A P T E R  1  

Quick Start 
 
This chapter describes the main features of the File Manager, and the Data Display. 

File Manager 

The File Manager is used to manage files on disk, search the contents of a drive or directory, and edit, 
plot, or draw the contents of a file.  This feature is similar to Windows Explorer with application specific 
functions tailored for the Power Utility Industry.  The functions include automatic event file association, 
specialized copy/move engines, intelligent queries, specialized report files, COMTRADE conversion and 
compression routines, merge and append waveform and load files, event summaries, and calibration 
reports. 

 

 

Figure 1.1  Event File Manager 
 
When the software is activated, the File Manager displays the subdirectories and files of the last active 
drive and directory.  This window consists of a folder tree, file table and a query bar.  The query bar is 
located below the table.  Refer to Figure 1.1.  The main features are described in the following sections. 



Chapter 1 - Quick Start 

 

2  

LONG FILE NAMING FORMAT 

The File Manager supports the IEEE long file naming convention.  The IEEE long file naming 
convention is a PSRC convention used to name time sequenced data files.  The file table columns are 
used to display the contents of the long file name. The file name contains the following first six required 
fields stored in a comma-delimited fashion.  The remaining fields are optional.  The file table lists 4 
optional columns at the end of the table to support user defined fields.  The ComNames properties 
dialog allows for user input for the first 2 optional fields. 
 
Example:  000112,123433234,-5S,South Arkey,DLP1,Sun Power,000003000,T,4287N,6587W.OCS 
 
Field Definitions: 
 

Field Example Displayed Definition 

Date 000112 01/12/2000 The Date field defines the fault date of the file.  The 
date fields are defined as: the first 2 characters are 
the year, the next two are the month and the last 
two is the day. (required) 

Time 123433234 12:34:33.234 The time field defines the fault time of the file.  The 
Time fields are defined as: the first 2 characters 
are the hour, the next two are the minutes, the next 
two are the seconds and the last two or three is the 
milliseconds. (required) 

Tcode -5S -5S The TCode field defines the difference between the 
time system used for start time and Universal 
Time.  -5s would be specified for US Eastern 
Standard Time.  If the start time is expressed in 
UT, this field is coded 0z, Note: UT is the 
international abbreviation for Universal Time, also 
called Greenwich Mean Time or GMT. (required) 

Substation South Arkey South Arkey The substation name or code where the originating 
device is located. (required) 

Device DLP1 DLP1 The device name or code that generated the file. 
(required) 

Company Sun Power Sun Power The company of the specifed substation. (required) 

Duration 000003000 000003000 The duration of the file. (optional) 

Type T T The fault type or contents type of the file. (optional) 

Latitude 4287N 4287N Latitude represents the geographical position of the 
substation.  The letter N indicates latitude in the 
Northern Hamisphere. (optional) 

Longitude 6587W 6587W Latitude represents the geographical position of the 
substation. The letter W indicates longitude in the 
Western Hamisphere. (optional) 

COMNAME(S) RENAME 

To rename time sequenced data files using the IEEE long file naming convention select the 
“ComName(s) Rename” option under the “File” menu. ComName(s) Rename will rename all the marked 
waveform files to the IEEE PSRC long file naming convention.  A message box will be prompted before 
renaming the file to insure the execution of the rename feature.  This feature will permanently rename 
the files.  It is advisable to back up the files before renaming.  Some proprietary applications may not be 
able to read the files once they are renamed.  Refer to Figures 1.2 & 1.3.  For a full description of the 
format refer to the Long file Naming Format above. 
     
All files associated with the marked Comtrade files will be renamed (".CFG", ".INF", ".HDR", ".DAT" and 
"*.D##" files). 
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Figure 1.2  ComNames Rename: Select & Mark all the Waveform Files to Rename 

 

 

Figure 1.3  ComNames Rename: Result 

COMNAME PROPERTIES 

The fields defined in the IEEE long file naming convention are not always available from the time 
sequenced files.  The “ComName Properties” dialog allows for setting the most common fields not 
available in the time sequenced formats supported.  User fields allow for setting specific information into 
the file name. Refer to Figure 1.4. 
 

• Company Name 

• Time Code 

• User Field 1 

• User Field 2 
 
The fields entered are used for all files renamed. 
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Figure 1.4  ComName Properties Dialog 

COMMAND LINE PARAMETERS 

There are a number of command line parameters supported in the Wavewin software. The listed 
command line parameters are specific for the file manager and data plotting window. Below is a list of all 
supported command line parameters and their description: 

 

Command Line Description 

Path & Filename If a path and filename is passed as a command line parameter then 
the path and filename must be surrounded by quotes, such as 
“c:\faultlibrary\event1.dat”. Wavewin will automatically open and 
display the file. 

/View The “/View” command line parameter is used along with a path and 
filename command line. It automatically opens and displays the file 
when Wavewin is executed. 

/Print The “/Print” command line parameter is used along with a path and 
filename command line. It automatically opens, displays and prints 
the file when Wavewin is executed. 

/Batch The “Batch” command line parameter is used along with a path and 
batch filename command line. It automatically opens the defined 
batch file and executes each command line parameter defined in the 
file. This feature is mainly used to print a number of files through one 
command line parameter. 

/Merge The /Merge command line parameter is used along with a path and 
filename command line. It will merge the file with all files that have a 
/merge command line parameter associated with them. The /merge 
command line parameter is defined in a Merged File.lst ASCII file. 
The Merged File.lst is passed to Wavewin through the command line 
parameters. All files listed in the Merged File.lst are automatically 
merged by time and if the files have different sampling frequencies 
then the highest frequency is used. The merged file is saved as an 
ASCII 1999 Comtrade file and placed in the same directory where the 
Merge File.lst is located. The Comtrade files are name Merged 
File.cfg and Merged File.dat. If an error occurs then a Merged File.log 
file is created listing all errors encountered.  
Example contents of a Merged File.lst: 
 C:\faultlibrary\event10.dat /merge /exit 
 C:\faultlibrary\event12.dat /merge /exit 
 C:\faultlibrary\event14.dat /merge /exit  

/X The “/X” command line parameter tells where to display Wavewin’s 
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left corner when executed.  

/Y The “/Y” command line parameter tells where to display Wavewin’s 
upper corner when executed. 

/W The “/W” command line parameter tells the width of the Wavewin 
application when executed. 

/H The “/H” command line parameter tells the height of the Wavewin 
application when executed. 

/Exit The “/Exit” command line will automatically exit Wavewin after all 
other command line parameters are fully complete. 

NAVIGATING 

FILES: 

To browse the files in the active directory use the up, down, right, left, page up, page down, home, 
end, ctrl+home, and ctrl+end keys, or use the scroll bars.   

DRIVES/DIRECTORIES: 

To view the contents of a directory, navigate through the folder tree or place the cursor on the 
directory name in the file table and press <enter> or double click on the desired folder.  Refer to 
Figure 1.5. The “.” and “..” displayed at the top of the file table provide shortcuts to the previous 
directory and the root directory.  To return to the previous directory, place the cursor on the “..” 

shortcut and press <enter> or click the Up  menu button or press the backspace key.  To return to 
the root directory, place the cursor on the “.” shortcut and press <enter>. 
 
To change the active drive letter, click the ChDir  menu button or press F7.  Enter the drive letter 
and path and click OK.  To return to the last active directory, enter only the drive letter.  To display 
the contents of the root directory, enter the drive letter, a colon, and a backslash, for example type 
“C:\”.  An error message is displayed if the software cannot find or open the specified path. 
 
To navigate through the last active directories click the Back  menu button or click the right 
mouse button to display a list of the connected drives and the last 12 navigated directories.  Refer to 
Figure 1.6. 

 



Chapter 1 - Quick Start 

 

6  

                          

Figure 1.5  Folder Tree                Figure 1.6  Drive/Directory Navigation Menu 

UPDATING THE ACTIVE DIRECTORY 

 Click the Refresh  menu button to update the contents of the folder tree and the file table or press 
F12.  To refresh the folder tree only right click on the folder tree and select the Refresh option. Refer to 

Figure 1.7.  To refresh the file table only right click on the file table and select the Refresh  
menu option.  
 

 

Figure 1.7  Folder Tree Popup Menu 
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MARKING FILES 

Files are marked and unmarked through the “Mark” menu option, the space bar, or the left mouse 
button.  Use the shift+left mouse button to mark a group of files or the ctrl+left mouse button to 
randomly mark files.  Marked files are displayed in red and can be copied (F8), moved (F9), deleted 
(Delete), grouped, sorted or used for reports. 

SORTING FILES 

The column headers displayed at the top of the table are used to sort all the files in the table.  Click the 

header buttons to toggle between ascending and descending order  or use the Sort menu 
option to sort all or marked files with respect to the selected sort field.  To change the sort field, place 
the cursor in the desired column and select “Set Sort Field” from the “Sort” menu.  The active sort field is 

displayed in the status bar at the bottom of the window.   

COPYING OR MOVING FILES 

 Files must be marked in order to copy or move them from the active directory.  To copy/move files 

using the Window’s Select Folder dialog click the Copy  / Move  menu buttons or press F8 for 
copy and F9 for move or select the “Copy To” or “Move To” menu options under the “Files” menu.  
Select an existing folder from the Folder tree or click the New Folder button to create a new folder 
under the selected folder. Modify the Name then press <enter>. Click the OK button to select the active 
folder.  Refer to Figure 1.8.  A message is displayed if an error occurs while coping or moving the files.  
Refer to the Copy/Move Files sections in Appendix B for more information.  The Cancel button or the 
<esc> key terminates the command. 
 

 

Figure 1.8  Copy Dialog 
 
To copy or move files to the clipboard select the “Copy/Cut” menu options under the “Edit” menu or 

right click in the file table and select the Copy  or Cut  option from the popup menu.  
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Navigate to the destination folder and select the “Paste” option under the “Edit” menu or the Paste 

 option from the file tables right click popup menu.  
 
Once the copy/move or paste commands are executed, the system's task bar in the upper right hand 
corner of the screen is updated after a file is successfully transferred to the destination directory.  All 
files that were unsuccessfully copied/moved using the Copy/Move menu buttons are marked and 
grouped at the top of the table. 
 
The specialized copy/move/paste engine copies the COMTRADE header and configuration information 
along with the selected data file.  For example, when a Comtrade data file is copied or moved the 
corresponding header information (“*.CFG”, “*.HDR” & “*.INF”) is automatically copied from the source 
directory to the destination directory.   

EMAIL FILES 

Files must be marked first (displayed in red) to email. Mark all of the files to email than click the Email 

menu button  or right click in the file table to display the popup menu and select the Email  
option or select the “Email Marked Files” menu option under the “Files” menu. The users default email 
program is displayed with all marked files in the attachment section. Also, any support files needed to 
display the selected files will be automatically attached. Support files include the Comtrade .CFG, .HDR 
and .INF files, refer to Figure 1.9. 
 

 

Figure 1.9  Email Dialog 



Chapter 1 – Quick Start 

9 

ZIP FILES 

Files must be marked first (displayed in red) to zip them. Mark all of the files to zip then click the “Zip 
Marked Files” menu option under the “File” menu or right click in the file table to display the popup menu 

and select the Zip  option. The zip dialog is displayed. Enter the filename and folder.  Click the 

Folder  button to browse and select a destination folder.  If no destination folder is defined then the 
zip file is saved to the file table’s active directory. Also, any support files needed to display the selected 
files will be automatically included in the zip file.  Support files include the Comtrade .CFG, .HDR and 
.INF files. The zip files created are compatible with the WinZip, PKZip and Window’s Zip applications. 
Refer to Figure 1.10. 
 

 

Figure 1.10  Zip Dialog 

CUSTOMIZING THE TABLE DISPLAY 

The columns displayed in the table can be repositioned through the “Display” menu option under the 
“Options” menu.  Refer to Figure 1.11.  Use the Move Up and Move Down buttons to change the 
position of a column.  The table columns can also be resized.  Position the mouse over the column 
separator and drag the mouse to the desired location or double click on the table separator to resize the 
column to the largest display. 
 

 

Figure 1.11  Customize Table Columns 
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PRINTING THE FILE TABLE 

 The print feature provides two options: print all or marked files in the active directory.  To print all the 
files, select the “Print/Print All Rows” menu option under the “Files” menu (Alt+F,P,A) or select the 
“Print/Print Marked Rows” menu option under the “Files” menu (Alt+F,P,M) to print only the marked files.  
An error message is displayed if the software cannot access the printer port. 

COMPRESSING COMTRADE ASCII FILES 

The File Manager contains a built in compression routine that converts COMTRADE ASCII files to 
COMTRADE Binary files.  To compress COMTRADE ASCII files, mark the files and select “Compress 
COMTRADE Files” from the “Options” menu. The software prompts for conformation, click Yes to 
continue, or No to cancel. 

SAVING AS COMTRADE 

Existing files can be converted to the COMTRADE ASCII or Binary format.  Currently there are two 
Comtrade versions supported: the older 1991 format and the newer 1999 format.  The Comtrade format 
can be selected from the “Data Plotting Window’s Properties” dialog.  The default format is the newer 
1999 format.  Refer to Figure 1.12.  To create a COMTRADE file place the cursor on the event file or 
mark the desired files and select the “Save As COMTRADE” (ASCII/Binary) menu option under the 
“Options” menu.  Enter the destination path and filename (do not enter a filename extension) and click 
OK.  The “.DAT” and “.CFG” files are automatically created.  If a path is not defined, the COMTRADE 
files are saved in the active directory.  
 
If the sample values in the selected file(s) are RMS calibrated and the outcome Comtrade file must have 
instantaneous values then set the “Comtrade Settings” fields to automatically convert the RMS data to 
instantaneous values.  To set the “Comtrade Settings” fields open the “Window Properties” dialog in the 
data display.  Select the “Comtrade” tab then select “Yes” for the “Convert RMS Calibrated Data to Peak 
Data”. 
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Figure 1.12  Comtrade Version 
 
To automatically convert the selected file(s) to Comtrade using the IEEE long file naming convention 
check the “Use the ComNames Naming Convention to Name the Comtrade File(s)” field in the “Save As 
Comtrade” dialog and leave the File Name field empty.  Refer to Figure 1.13.  All files marked in the 
table will be converted to the selected Comtrade format and will be named using the IEEE long file 
naming convention. 
 

 

Figure 1.13  Save As Comtrade 
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RUNNING APPLICATIONS 

Files that contain the extension EXE, BAT, and COM can be activated from the file table.  To run an 
application from the active directory place the cursor on the filename and press <enter> or double click 
the left mouse button.  To run an application from a non-active directory select “Run” from the File 
menu, enter the path and the filename in the “Open” field, and click OK.  Refer to Figure 1.14. 
 

 

Figure 1.14  Run Dialog 

DISPLAYING COMTRADE OSCILLOGRAPHY RECORDS 

The Comtrade format supports waveform and load data.  To plot the contents of a Comtrade file double 
click on the “.DAT” file or move the table cursor to the “.DAT” file and press enter.  The system will 
determine how to display the data (waveform or load) by the time samples in the file. 
 
A maximum of 10 display windows can be opened at one time.  Refer to the “Data Display” section for 
more information. 

ASSOCIATING FILE TYPES 

The File Manager automatically associates file types according to the file naming structure.  The 
associated driver is displayed in the driver column.  When the <enter> key is pressed or the left mouse 
button is double clicked the software inspects the filename at the cursor position and executes the 
assigned driver.  Files are associated according to the following parameters: 
 

Driver Association Parameter 

Directories  Directories are tagged according to the parameters read from the file allocation 
table. 

Applications  Files that have the extension “.BAT”, “.COM”, or “.EXE” are tagged as application 
files. 

COMTRADE  Filenames that have the extension “.DAT” and there exists a cooresponding 
“.CFG” file are tagged as COMTRADE files. 

TIS Files that have the “.TIS” extension are tagged as TIS (Wavewin Sniffer)  files. 

Audio Wave  Files that have the extension “*.WAV” are tagged as Window’s Wave files. 

Application Files  Word Documents (“.Doc” & “.RTF”) , Execl Documents (“.XL”, ”.XLS”, “.XLT”, 
“.XLM”, “.XLA”, “.XLC” & “.XLW”) , Web pages (“.HTM”, “.HTML”, “MSPX” & 
“ASP”) , Access Files ('”MDB” & “.ADP”) , Power Point Presenation files (“.PPT” 
& “.PPS”) , Image files (“.GIF”, “.TIF”, “.JPG”, “.JPE”, “.BMP”, “.PSD” & “.PDD”) , 
Zip files (“.ZIP”) , and PDF files (“.PDF”)  are automatically associated with their 
source application. 

ASCII All other files are tagged as ASCII files. 

 
To change the driver type, place the cursor on the filename and select the driver from the Drivers menu.  
Once a driver is assigned the file contents appears in the corresponding display window.  The following 
drivers are supported: 
 
ASCII (Text)  



Chapter 1 – Quick Start 

13 

Hexadecimal (Binary)  
Table (Comma Delimited, Double Quotes/Comma Delimited, Tab Delimited)  
DXF 
COMTRADE (ASCII and Binary)  
TIS (Wavewin Sniffer) 
WAVE (Microsoft’s Wave Files) 
 
The “Auto Detect” feature inspects the file at the cursor position and tags it according to the file name.  

VIEWING/MODIFYING ASCII FILES 

The ASCII editor allows for viewing and/or modifying the contents of a text file.  To open an ASCII file 

place the cursor on the filename and press F2, or click the Edit menu button.   Use the up, down, 
right, left, ctrl+right, ctrl+left, page up, page down, home, end, ctrl+home, and ctrl+end keys, the scroll 

bars or the search (F4) and search again (F3)  features to navigate through the file contents.  The 
line and character number at the cursor position is displayed in the status bar (bottom left corner of the 

window).  Refer to Figure 1.15.  The Cut (ctrl+x) , Copy (ctrl+c) , and Paste (ctrl+v)  
commands are also provided.  New files can be created or existing files can be opened, saved and 
saved under a new name.  A maximum of 10 editing windows can be opened at one time.  
 

 

Figure 1.15  ASCII Editor  
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VIEWING/MODIFYING BINARY FILES 

The Hexadecimal editor allows for viewing and/or modifying the contents of a binary file.  To open a 
binary file, place the cursor on the file and press F3.  The Hexadecimal window consists of a hex editor 
and an ASCII display.  Refer to Figure 1.16.  When a hex value is entered, the ASCII equivalent 
appears in the window to the right of the editor.  To navigate through the file contents use the up, down, 
right, left, page up, page down, ctrl+home, and ctrl+end keys or the scroll bar.  The byte number at the 
cursor position is displayed in the lower left corner of the window.  To search the contents of a hex file 
use the search (F4) and search again (F3) functions.  To search the ASCII window enter the ASCII 
information into the “Find Text” Field.  To search for a hex value enter “#” then the hex number into the 
“Find Text” field.  Refer to Figure 1.17.  
 

 

Figure 1.16  Hexadecimal Editor 
 

 

Figure 1.17  Hexadecimal Search 

VIEWING WAVEFORM SUMMARIES 

The File Manager and Data Display features generate analog and digital summaries for the supported 
oscillography formats.  The summary engine extracts key information from the file and saves it to a 
small summary file.  The header, analog, and digital information includes: 
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Event Information 

Field  Description 

Station Name of the Station associated with the event file. 

Filename Name of the event file. 

File Size File size (displayed in kilobytes). 

Prefault-Time Date and time of the first prefault sample. 

Fault-Time Date and time of the first fault sample. 

Save-Time Date and time the file was saved to disk. 

Process-Time Date and time the file summary was processed. 

Start Date & 
Time 

Date and time of the first sample in the file. 

End Date & Time Date and time of the last sample in the file. 

File Duration Duration of the file measured in days, hours, seconds, milliseconds and/or 
microseconds, depending on the type of file. 

Sampling 
Frequency 

Sampling frequency and the time between each sample. 

Line Frequency Line Frequency defined in the file. 

 
Highest/Lowest Analog Peak Chart 

Field  Description 

HPeak-Up Highest positive peak. 

HPeak-Dn Highest negative peak. 

LPeak-Up Lowest positive peak. 

Lpeak-Dn Lowest negative peak. 

OneBit Channel's full-scale value divide by the channel's resolution. 

pU Channel prefix and unit. 

Description Channel title and number. 

HP-Dif Absolute value of the HPeak-Up minus absolute value of the HPeak-Dn divided by 
the OneBit value.  ((HPeak-UP – HPeak-Dn)/OneBit) 

LP-Dif Absolute value of the LPeak-Up minus absolute value of the LPeak-Dn divided by 
the OneBit value.  ((LPeak-UP – LPeak-Dn)/OneBit) 

 
Events/Sensors Activity Summary 

Field  Description 

Fst State the channel started at, A=alarm and N=normal. 

Lst State the channel ended at, A=alarm and N=normal. 

Fst-Change Date and time the channel first changed state. 

Lst-Change Date and time the channel last changed state. 

Changes Number of times the channel changed state. 

Description Channel title and number. 

 
Events/Sensors Activity Log 

Field  Description 

State State of the channel at the triggered time, A=alarm and N=normal. 

Trigger Time Time the channel-changed state. 

Description Channel title and number. 

 
The xx:xx:xx.xxx displayed in the “Fst-Change” and/or “Lst-Change” fields of the Events/Sensors Activity 
Summary indicates that the digital channel’s state did not change from the initial state (Fst).   

To generate a summary file, place the cursor on the filename and click the Summary  menu button or 
select the “Waveform Summary” menu option under the “Options” menu.  Refer to Figure 1.18. 
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Figure 1.18  Waveform Summary 

WAVEFORM FILE(S) OPTIONS 

OPEN SELECTED FILE 

The open selected file option opens the waveform file at the cursor position.  Refer to the Displaying 
Oscillography Records section for a list of the supported waveform files. 

OPEN ALL MARKED FILES 

The open all marked files option will open all of the marked waveform files, tile the waveform files 
horizontally and minimize the file manage.  To bring up the file manager click the files menu button. 

 
 
A maximum of 10 data windows can be opened at one time. 
 

The plot button icon  will plot all the marked files. If there are no marked files then it will plot the 
selected file. 

APPEND WAVEFORM FILES 

The append waveform files option will append the marked files according to time.  There are two 
options available under the Append Menu: 

• Discard Common Times: Any common times found in the marked files will be deleted from 
the older file.  Refer to Figure 1.19. 

• Back to Back: The files are appended back to back.  No samples are deleted.  Refer to 
Figure 1.20. 
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Figure 1.19  Append Waveform Files: Discard Common Times 
 

 

Figure 1.20  Append Waveform Files: Back to Back 
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MERGE WAVEFORM FILES 

The merge waveform files option will merge the marked waveform files. There are two options 
available under the Merge Menu: 

• By Time: Merge channel samples if they have a common time segment.  The reference time 
is from the file with the latest start date and time.  The file with the least amount of samples 
determines the length of the new merged file.  Refer to Figure 1.23. 

• By Sample:  Merge regardless of time stamps.  The reference time is from the first marked 
file.  And the file with the least amount of samples determines the length of the file.  Refer to 
Figure 1.24. 

 
When files with different sampling frequencies are merged a dialog will be displayed. The dialog 
contains a list of all the sampling frequencies in the marked files.  Select the frequency for the 
merged file or enter a new frequency.  Refer to Figure 1.21. 
 

 

Figure 1.21  Merge Waveform Files: Select Frequency 

 
If the merged files have different data types (RMS Calibrated or Peak Values) then the RMS values 
will be converted to Peak values by multiplying the RMS values by Root 2. 
 
To identify the merged channels the station name for each file is added to the beginning of the 

analog and digital channel names.  To turn off this feature open the “Properties” dialog  in the 
data-plotting window.  Click on the “Append/Merge” tab and uncheck the “Add the File’s Station 
Name to Beginning of the Analog/Digital Channels” field.  Refer to Figure 1.22. 
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Figure 1.22  Append/Merge Properties 
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Figure 1.23  Merge Waveform Files By Time 
 

 

Figure 1.24  Merge Waveform Files By Sample 
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FILE REPORTS  

GENERATING CALIBRATION REPORTS 

The calibration feature performs the following calculation on the analog channels of the selected 
DFR file.  If one of the calculations is true, the channel is displayed in the report: 
 

The HP-Dif is greater than 2.5 times the OneBit. 
The LP-Dif is greater than 2.5 times the OneBit. 
The difference between the HPeak-Up and LPeak-Up is greater than 2.5 times the OneBit. 
The difference between the HPeak-Dn and LPeak-Dn is greater than 2.5 times the OneBit. 

 
Calibration reports should only be generated on files that contain no fault data such as snap shot 
files.  To generate a report, mark the desired files and select “Calibration Report” from the “Options” 
menu.  The information contained in the report corresponds to the data displayed in Analog Peak 
Chart section of the Waveform Summary.  Refer to the previous section for field descriptors.  The 
report information is saved in the DVREPORT.DTB file located in the system directory. 

GENERATING SEQUENCE OF EVENTS (SOE) REPORTS 

To generate a table of sequence of events  for multiple waveform files, first mark all the desired files 
then press F11 or Select the "SOE List" menu option from the "Reports" submenu under the 
"Options" menu.  A table will be displayed listing all the events triggered in the selected files.  Refer 
to Figure 1.25.  The table is sorted according to date and time.  The columns listed in the table 
include: 
 

State:  The state on the event/sensor at the displayed date and time (A=Abnormal, N=Normal). 
Trigger Date:  The date the event/sensor triggered or cleared. 
Trigger Time:  The time the event/sensor triggered or cleared. 
Chan:  The channel number of the event/sensor in the file it was read from. 
Channel Title:  The channel title of the event/sensor. 
Device:  The device the event/sensor originated from. 
Substation:  The substation the event/sensor originated from. 
File:  The file name the event/sensor originated from. 

 
The Query section at the bottom of the table allows for searching events from specific substations, 
devices, and channels...  To plot the file containing the specific events press enter or double click on 
the event. 
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Figure 1.25  SOE List 

GENERATING SEQUENCE OF EVENTS (SOE) SUMMARIES 

To generate a summary of the sequence of events  for multiple waveform files, first mark all the 
desired files then Select the "SOE Summary" menu option from the "Reports" submenu under the 
"Options" menu.  A table will be displayed listing a summary of all the events triggered in the 
selected files.  Refer to Figure 1.26.  The table is sorted according to date and time.  The columns 
listed in the table include: 
 

Substation:  The substation that triggered the event/sensor. 
Device:  The device that triggered the event/sensor. 
Fst-State:  State the channel started at, A=alarm and N=normal. 
Lst-State:  State the channel ended at, A=alarm and N=normal. 
Fst-Change Date:  Date the channel first changed state. 
Fst-Change Time:  Time the channel first changed state. 
Lst-Change Date:  Date the channel last changed state. 
Lst-Change Time:  Time the channel last changed state. 
Changes:  Number of times the channel changed state. 
Chan #:  Channel number in the file. 
Channel Title:  The channel title of the event/sensor. 
File:  The file name the event/sensor originated from. 

 
The Query section at the bottom of the table allows for searching events from specific substations, 
devices, and channels...  To plot the file containing the specific events press enter or double click on 
the event. 
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Figure 1.26  SOE Summary 

APPENDING LOG FILES 

The append log features will combine an unlimited number of log files into one file.  The files must be 
marked and of the same type (generated from the same device).  The generated combined file can 
be displayed in a table or plotted in the data plotting window.  This feature allows for analyzing load 
data over a long period. 

COMBINDING LOG FILES 

The combine log features will combine an unlimited number of log files into one file.  The files must 
be marked and can be from different file types (generated from different devices).  The substation 
and device of each file is added in the file. The saved file can be displayed in a table.  This feature 
allows for analyzing load data over a long period for different devices. 

VIEWING CAD-DXF FILES 

The CAD-DXF viewer reads and displays the contents of a Drawing Exchange Format (DXF) file.  Refer 
to Figure 1.27.  DXF files can be created using an off-the-shelf program such as AutoCAD, Turbo CAD, 
Technical Visio, Drafix, or MEDUSA.  To view a DXF file double click the left mouse button on the DXF 
filename.  The viewer allows for opening and closing of DXF files, changing display resolution, setting 
zoom ratio, and selecting background color.  It also provides zooming and printing capabilities. 
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Figure 1.27  DXF Viewer 
 
The status bar at the bottom of the screen displays the X and Y coordinates of the mouse position, the 
maximum X and Y coordinates of the drawing, the active tab number and the total number of tabs in the 

window.  Refer to Figure 1.27.  To zoom in on a given area use the ZoomIn  and ZoomOut  

menu buttons.  To view the drawing in its original size click the Original Display  menu button, or 

click the Fit to Window  menu button to resize the drawing to fit in the window.  Use the Open File 

 menu button to add DXF files to the window.  Click on the Close File  menu button to close an 
open DXF file.   
 

The Zoom Scalar selectable box  is used to increase or decrease the drawing’s 
display resolution.  For example, when the Zoom In feature is activated the drawing's X and Y resolution 
values are multiplied by the Zoom IN/OUT Ratio to increase the resolution and when the Zoom Out 
feature is activated the drawing's X and Y resolution values are divided by the Zoom IN/OUT Ratio to 
decrease the resolution.   
 

The Const  menu button allows for changing the file, the drawing’s display resolution, and the 
background color.  Refer to Figure 1.28.  The dialog fields are described below: 
 

Field Description 

File Name The path and the DXF filename.  Default: Empty.  Use the “…” button to 
browse for a file.  

Background Color The background color for the displayed DXF file. Defult: White. 

Max X Pixels The maximum number of X pixels used to display the DXF file.  Enter an 
integer value.   

Max Y Pixels The maximum number of Y pixels used to display the DXF file.  Enter an 
integer value.   
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Use the tab or shift+tab keys to navigate between fields and the up and down arrow keys to view the 
selectable options.  Click Apply to view the changes, OK to accept the changes, or Cancel to terminate 
the changes. 
 

 

Figure 1.28  DXF Drawing Constants 

VIEWING ASCII FILES IN DATABASE FORMAT 

The database viewer provides an effective way to organize, sort, and search comma delimited, double 
quoted comma delimited, or tab delimited text files.  Refer to Figure 1.29.  The data is presented in 
tabular form and an unlimited number of rows and columns can be displayed.  The viewer allows for 
intelligent queries, column sorting, selecting and grouping data, row deletion, printing, saving and saving 
in a new file. 
 
Use the column headers to sort the data in ascending or descending order and the query fields to 
search the data.  Refer to the “Querying Files” section for more information.  To browse the data use the 
up, down, right, left, page-up, page-down, home, end, ctrl+home, and ctrl+end keys or use the scroll 
bars.  Rows must be marked in order to delete them from the table. 
 
The database viewer is useful for processing COMTRADE data files, employing undertriggers and 
overtriggers, locating instantaneous maximum and minimum peak values and analyzing load 
information. 
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Figure 1.29  Database Viewer 

SHOW/HIDE CHANNEL TITLES 

The data plotting window automatically hides channels that contain certain characters in the channel 
title. Below is a list of the characters defined to be invalid channels when a file is displayed.  
 

• UNUSE 

• UNDEF 

• NOT D 

• NOT U 

• NOT I 

• NOT A 

• { 

• N/A 

• ANALOG INPUT 

• UNTITLED 

• ANALOG CHANNEL 

• EXTERNAL INPUT 

• EVENT CHANNEL 

• CHANNEL: 

• DIGITAL TRACE # 

• SPARE 
 
If a channel title contains the above characters in the beginning of the title then that channel is 
automatically hidden. These characters can be modified to show a channel when a file is displayed. To 
show a title that contains the above characters open the Show/Hide Channel titles dialog. Refer to 
Figure 1.30. 
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Figure 1.30  Show/Hide Channel Titles Dialog 

 
To show a title, uncheck the checkbox next to the displayed invalid channel title. To remove a title from 
the list select the title in the list box then click the “Remove” button or press the delete key. To add a 
new title first, type the new title in the edit box then click the “Add” button. The new title will be added to 
the end of the list with the checkbox automatically checked.  

QUERYING FILES 

The query fields are used to search the information in the tables.  Query fields are located below the 
table.  Refer to Figure 1.31.  Use the tab key to move the cursor from the table to the query fields and 
up arrow to return to the table. The Ctrl-left/right keys moves between each query field. Each field 
contains a criteria and an operator.  The criteria is directly entered from the keyboard, and may include 
the “*” and “?” wild cards.  Operators are located above the criteria fields and can be changed by 
clicking the left mouse button on the operator symbol or by pressing the F9 key.  The selectable options 
include equal to (=), less than (<), and greater than (<).  
 

 

Figure 1.31  Query Fields 
 
When a query is launched, the engine numerically compares the criteria with the information in the 
table.  If numerical comparison is not possible then symbolic comparison is performed.  When multiple 
fields are defined, the engine searches for a match on the first field “AND” on the second field “AND” on 
the third field and so on. 
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Three query options are available: Query All Files, Query Marked Files, or Query Unmarked Files.  Files 
that meet the specified query requirements are marked, grouped, and displayed at the top of the table.  
Use the Ctrl-left/right keys to navigate through the query fields and the <enter> key to process the 
criteria at the cursor position. 

Data Display 

The Data Display offers a high-resolution graphical interface for displaying, analyzing, and manipulating 
analog and digital channels of an oscillography record or a periodic load file.  Refer to Figure 1.32.  
Displayed channels can be marked, merged, appended, moved, zoomed, removed, restored, 
superimposed, scaled, numerically processed, and summarized.  A maximum of 10 data windows can be 
opened at one time. 
 

 

Figure 1.32  Data Display 

 
The Data Display contains two sections: the analog view and the digital view.  The analog view plots the 
oscillography or load data and displays the channel’s highest peak, RMS, phase, reference, 
instantaneous, maximum, and minimum values and so on.  The cursor bars are used to view the data 
values.  The digital view plots the events and sensors and displays the channel’s original state, final state, 
time of the first change, time of the last change, and number of times the channel-changed state. 
 
Up to 256 analog and 1024 digital channels can be displayed.  The main features are described below. 
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PHASORS  

The phasor diagram shows a vector for each visible analog channel.  The diagram is displayed to the 
right of the analog information window.  Refer to Figure 1.32.  To increase or decrease the size of the 
phasor window place the cursor over the vertical separator between the analog information window and 
the phasor window and drag the mouse to the left to increase or to the right to decrease.  To close the 
phasor window click the close button located in the header. To navigate the phase angles use the left 
arrow, right arrow, home, end, page up and page down keys or the data scroll bar.  To 
increase/decrease the length of a channel's vector along with the amplitude of the oscillography channel 

first mark the channels and use the increase/decrease amplitude menu buttons or the Ctrl-Up 
and Ctrl-Down keys. To only increase/decrease the length of the vectors use the up and down phasor 

buttons.  
 
To toggles between the phasor display and the circular chart display click the “P” button above the 

phasor display for phasors or the “C” button for a circular chart . 
 
There are 2 types of phasor displays: non-referenced and referenced, refer to Figure 1.33.  The non-
referenced display shows the phase angle for each sample in the display.   The reference display shows 
the phase angle for each sample with respect to the reference channel.  The reference channel is the 
first marked channel in the window.  All angles at a sample are subtracted from the reference angle.  If 
there are no marked channels the non-referenced display is shown. 

 

Figure 1.33    (a) Non-Referenced Phasors       (b) Referenced Phasors 

HARMONICS 

The harmonics window displays as many harmonics as possible based on the file’s sampling frequency. 
A maximum of 200 harmonics can be displayed in the table. Refer to Figure 1.35. To display the 
harmonics window right click in the phasor diagram or in the analog information section and select the 
Harmonics menu option. The harmonics window displays the harmonics for the first marked analog 
channel or if no channels are marked then the first visible channel. Changing the marked channel in the 
data plotting window will update the harmonics window with the appropriate channel.   
 
The harmonic calculation is performed on one cycle of data, starting at the RMS bar and going forward 
to the data bar.  There are 3 fields displayed at the bottom of the harmonics table and histogram; 
TrueRMS, CalculatedRMS and Total Harmonic Distortion (THD).  The TrueRMS field displays the RMS 
value calculated using the samples in the active cycle displayed in the waveform trace window.  The 
CalculatedRMS field displays the square root of the summation of the squares of the DFT Magnitudes 
from harmonics 2 to the maximum harmonic divided by square root of 2. The THD field displays the 
square root of the summation of the squares of the DFT Magnitudes from harmonics 2 to the maximum 
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harmonic divided by the square root of 2 and that quantity divided by the DFT Magnitude of the 
Fundamental.   
 
The harmonics can be viewed in a table format or in a histogram. Click on the harmonics toggle button 

 to change the view. Refer to Figure 1.36. The histogram can show only one column from the table.  
To change the column of data displayed click the histogram drop down menu and select the column. 
Refer to Figure 1.34. The default view is the % of Fundamental.  
 

. 

Figure 1.34  Histogram Drop Down Menu 
 
Also, a vector for each harmonic is displayed in the phasor diagram.  To hide/show the harmonic 
vectors toggle the "Vector Harmonics" menu option under the "View" menu from checked=on to 
unchecked=off. 
 

 

Figure 1.35  Harmonics Table View 
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Figure 1.36  Harmonics Histogram View 

PERIODIC LOG FILES 

The periodic log viewer allows for viewing and analyzing large amounts of event data in a single display.  
Refer to Figure 1.37. The data is displayed in envelope form and may contain one day, one week, one 
month or one year of event data.  This feature is useful for load flow analysis.   
 
A circular chart of the data displayed in the trace window is plotted to the right of the channel 
information window.  The circular chart cursor is positioned on the sample at the waveform data bar.  
The duration of the data displayed is also shown below the circular chart along with the sample number 
at the cursor bar. 
 
 



Chapter 1 - Quick Start 

 

32  

 

Figure 1.37  Periodic Log File 

CIRCULAR CHART 

 The circular chart diagram shows a circular display for each visible channel.  The diagram is displayed 
to the right of the analog information window.  Refer to Figures 1.37 and 1.38.  The amount of data 
displayed in the circular chart is equal to the amount of data displayed in the waveform trace window.  
The duration of the data displayed is shown at the bottom of the circular chart.  To increase or decrease 
the size of the circular chart window place the cursor over the vertical separator between the analog 
information window and the circular chart window and drag the mouse to the left to increase or to the 

right to decrease.  To close the circular chart window click the close button  located in the header. 
 
To navigate the circular chart use the left arrow, right arrow, home, end, page up and page down keys 
or the data scroll bar.  There is a cursor bar on the circular chart that allows you to see where you are in 
the data. To increase/decrease the display area of a channel on the circular chart, mark the channel 
and use the increase/decrease amplitude menu buttons or the Ctrl-Up and Ctrl-Down keys or use the up 

and down arrow button  located in the circular chart header.  
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Figure 1.38  Circular Chart 

DISPLAY DRIVER’S DATA TYPE 

The data stored in the displayed file can be instantaneous values or RMS values. The default setting for 
the supported files is instantaneous values. If the sample values are RMS calibrated then set the data 
type to “RMS Calibrated”.  If the data is RMS calibrated and the data type is not set properly then the 
analog column data will be displayed incorrectly.  To set the driver’s data type click the “Window 

Properties”  menu button from the speed bar or select the “Window Properties” option under the 
“File” menu.  Click the “Driver Data Type” tab and set the “Display Device’s Data Type” field to “RMS 
Calibrated” for RMS calibrated values and “Peak Type” for instantaneous values. Refer to Figure 1.39. 
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Figure 1.39 Analog Data Type Setting 

REOPEN WAVEFORM FILE 

To reopen a waveform file that was previously viewed click the reopen menu button  and select 
one of the files from the drop down list. Refer to Figure 1.40. 
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Figure 1.40 ReOpen Data File 

EMAIL ACTIVE FILE 

The active data file can be emailed by clicking on the email  menu button or by selecting “Email 
Active File” from the “File” menu. All support files associated with the open file are included as 
attachments. 

NAVIGATING 

 Use the up and down arrow keys or the vertical scroll bar to browse the analog channels.  The tab key 
toggles between the analog and digital views. 
 
The analog and digital values are displayed in a table to the right of the channel traces.  Hold the left 
mouse button down and drag the table separator bars to resize the viewing area.  To view the analog 
sample values use the following navigation tools: 
 

• Left and right arrow keys to navigate sample by sample 

• Ctrl+left or ctrl+right keys to peak navigate 

• Shift+ctrl+left or shift+ctrl+right keys to cycle hop 

• Home and end keys to display the channel’s first and last samples 

• Triangle  at the bottom of the data bar to drag the data bar through the samples 

• Page up and page down keys to page through the samples 

• Left button  displayed to the left of the data scroll bar to move the sample at the data bar to 
the position of the first sample displayed 

• Left button  displayed to the right of the data scroll bar to move the trace and table separator 
to the position of the data bar 

 

Click the left/right arrow button  (located to the right of the analog table headers) or use the shift-
right/left arrows to scroll through the analog table columns.  Refer to “Viewing Analog Data” section for 
field descriptions.  
 
NOTE:  If no channels are marked the ctrl+left and ctrl+right arrow keys peak navigate and cycle hop 
the cycles displayed in the first channel. 
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SETTING THE CURSOR BARS 

 Four vertical cursor bars are displayed in the analog view: the blue dotted line represents the reference 
bar, the black solid line represents the data bar, the black dotted line represents the RMS bar and the 
red dotted line represents the fault position defined in the configuration file.  There are also two 
horizontal bars displayed when the “Horizontal Bars” menu option under the “View” menu is checked.    

DATA BAR 

The data bar is displayed as a black solid line with a white triangle below the line. The data bar starts 
at the end of the first cycle in the data file. To move the data bar use the left and right arrow keys to 
move one sample, use the Ctrl-left and Ctrl-right keys to peak hop, use the Shift-Ctrl-left and Shift-
Ctrl-right keys to cycle hop, use the page up and page down keys to move one page up or down or 
left click the mouse to move to any position in the data or drag the triangle to scroll through the data. 
When the mouse is held over the triangle a hint message displays the sample number at the data 
bar and the delta time from the first sample displayed.  The time of the sample at the data bar is 
displayed in the D&T status bar field.  The channel values at the data bar are displayed to the right 
of the traces in the analog channel information table.   

REFERENCE BAR 

The reference bar is displayed as a blue dotted line. The reference bar is positioned at the fault time 
specified in the file.  To move the reference bar to the position of the data bar use the "Move 
Reference Bar to Data Bar" option inside the “View” menu or press Ctrl-A or click the SetRef menu 

button .  To move the reference bar to any position in the data area, click the right mouse button.  
The status field Delta time (Dt) in the status bar at the bottom of the screen, shows the time 
difference, in milliseconds or seconds, between the reference bar and the data cursor bar.  It also 
shows how many cycles are between the two bars. The instantaneous channel values at the 
reference bar are displayed to the right of the traces in the analog channel information table. 

RMS BAR 

The RMS bar is displayed as a black dotted line. The RMS bar is defaulted to always be one cycle 
away from the data bar, except when the data bar is positioned at the beginning of the data. This bar 
is used for calculating the RMS value displayed in the analog table view. The RMS value in the 
analog table is calculated using all of the sample values displayed between the data bar and the 
RMS bar. To move the RMS bar to the position of the reference bar (blue dotted line) use the "Move 

RMS Bar to Reference Bar" option inside the “View” menu or press Ctrl-Z or click the SetRMS  
menu button.   

FAULT BAR 

The fault bar is displayed as a red dotted line. The fault bar is fixed and positioned at the fault time 
defined in the configuration file. The fault bar can be shown or hidden by selecting “Yes” or “No” for 
the “Show Vertical Fault Bar” field in the properties dialog under the “Display Settings” tab. 

HORIZONTAL BARS 

When the “Horizontal Bars” menu option under the “View” menu is checked two horizontal bars will 
be displayed.  The solid black line follows the data bar and the dotted blue line follows the reference 
bar. The bars will be positioned at the first marked analog channel (displayed in red), if no channels 
are marked then they are positioned at the first displayed channel.  The Delta Y field in the status 
bar shows the difference between the two bars. 

 

To automatically resize the RMS sliding window click on the Resize Sliding Window menu button  
or open the “Set Sliding Window Size” menu option under the “View” menu.  Refer to Figures 1.41 to 
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1.43. To manually resize the RMS sliding window click the right mouse button to set the reference 

position and the left mouse button to set the ending data position then click the SetRMS  menu 
button.  The RMS bar is moved to the reference position.  The Delta time (Delta X) field displayed in the 
status bar at the bottom of the screen shows the time difference (in milliseconds) and the number of 
cycles between the reference and data bars.  Use the left, right, ctrl+left, and ctrl+right keys or the 
horizontal scroll bar to move the sliding window. 
  

         

Figure 1.41 Resize Sliding Windows Drop Down Menus  

 

 

Figure 1.42 Resize Sliding Dialog for Waveforms  

 

 

Figure 1.43 Resize Sliding Windows Dialog for Log Files 

SAVE DISPLAYED VALUES 

The save displayed values feature saves all displayed values in the analog table to a common delimited 
file (default format), to a user defined format file or to the Windows clipboard.  To setup the waveform 
display, for saving values follow the following steps:  

SELECT ANALOG COLUMNS 

All columns displayed in the table will be saved to the selected values file. Move the data bar along 
the waveform to change the sample values displayed in the table 
 



Chapter 1 - Quick Start 

 

38  

To change the way the columns are displayed open the "Properties" dialog located in the "File" 
menu.  Select the "Analog Table" tab.  A list of all the available analog columns is displayed.  Use 
the "Move Up" and "Move Down" buttons to change the order of the columns and the check box next 
to each column header to hide or show the column (checked =show, unchecked=hide). 
 
Resizing the Analog table can also isolate the columns to save.  Use the Shift-left and Shift-right 
keys to navigate through the columns.  Navigate to the first column to be saved then resize the 
window by dragging the table/phasor separator bar to show only the columns needed. 

SELECT ANALOG CHANNELS 

The template file can define channels to save in two ways: by the visible position of the channel or 
by specifying the actual channel number.  If the template defines channels to save by position then 
the channels displayed have to be selected and arranged properly to match the template file.  In 
both methods the channel values must be visible in the analog table. 
 
To isolate certain analog channels mark the desired channels.  Marked channels are plotted in red.  
To mark a channel move the channel cursor to the channel and press the spacebar or click on the 
channels number or table values.  After marking all the desired channels press enter <CR>.  The 
selected channels will be displayed only. 

ARRANGE ANALOG CHANNELS 

To arrange the analog channels in a specific order mark the channels to be moved and press the "+" 
key to move them up or the "-" key to move them down. 

SETUP THE VALUES FILE 

Before saving values to the Values file the file must first be defined.  To create or change the 
existing file select the "New" option from the "Values File" submenu under the “Values” menu.  Type 
in a new file name or select an existing file from the list.  The new file will automatically be created. 

MARK & SAVE 

To save values to a file move the data bar to the desired sample and select the "Mark & Save" 
option under the "Values" menu.  The sub menu allows for selecting the default format or a user 
defined format.  The default format is the basic format defined in the "Values File" tab in the 
"Properties” dialog.  Refer to the "User Templates" section below for more information on the user-
defined formats.  All user defined template files must be saved in the Wavewin directory and have an 
extension ".TMP" to be listed in the template menu. 
 
Once the format is selected the sample at the data bar is marked and all of the values in the table 
are saved to the selected values file.  Marked samples have a red upside down T displayed at the 
top of the window.  To clear the marked samples select the "Clear Marked Values" menu option 
under the "Values" menu. 

OPEN VALUES FILE 

To view the contents of the Values File select the "Open" option under the "Values File" submenu.  A 
notepad window will be displayed.  Refer to Figure 1.44. This window allows for editing the file, 
saving any changes, saving the file under a new name and for opening other Value files. 
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Figure 1.44  Values File 

CLEAR VALUES FILE 

The "Clear" option under the "Values File" submenu or the “Clear” button inside the “View Values” 
window will clear the contents of the file.  Use this feature if the Value File always stays the save and 
new value files are create using the "Save As" button in the "View Values" window or if a mistake 
was made during saving and the file needs to be cleared to start over. 

DEFAULT FORMAT 

The "Values File" tab in the "Properties" dialog defines the default format for saving displayed values 
to the Values file. 
 
Below is a description of each field: 
 

• Save To - Select file to save the values to an ASCII text file, select clipboard to have the 
values go directly to the Windows clipboard or select both for both features. 

• Select Values File - Select an existing file or create a new file.  If the file does not exist a 
message will be displayed asking to create the file upon exit of the dialog. 

• Save Type - Select Rewrite to clear the file before every save or select Append to add the 
values to the existing file. 

• Save Format - Select Fixed ASCII to format the data as a table or select comma delimited to 
save the values separated by a comma. 
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• Add Titles - Select “Yes” to add the titles of the column to the file or “No” to define no titles 
(Used in the Default format only). 

USER FORMATS 

User formats are used to create custom templates for saving the displayed values.  The user formats 
are selected from the “Mark & Save” menu.  User format files must be saved to the active Wavewin 
directory and have an extension ".TMP" to be listed in the “Mark & Save” menu. 
 
The format files can contain any ASCII text.  Tags are used to define where the specified values are 
to be placed in the values file.  When saving channel information the channel values must be visible 
in the analog table. 
 
Available Tags: 

• <Channel position #> - the position of the visible channel in the data plotting window. 

• <^Channel #> - the channel number displayed in the data plotting window. 

• <station> - the station displayed in the first status field. 

• <date>    - then date displayed in the D&T status field. 

• <time>    - then time displayed in the D&T status field. 
 

Refer to Appendix A for examples of format files and their results. 

OPEN FORMAT FILE 

To view the contents of a format file select the "Open" option under the "Format Files" submenu.  A 
notepad window will be displayed.  This window allows for editing the file, saving any changes, 
saving the file under a new name and for opening other Format files. 

CREATE NEW FORMAT FILES 

To create a new Format File select the "New" option under the "Format Files" submenu.  A notepad 
window will be displayed.  This window allows for adding text to the file, saving any changes, saving 
the file under a new name and for opening other Format files. 
 
User template files must be saved to the active Wavewin directory and have the extension “.TMP” to 
show up in the “Mark & Save” menu. 

MARKING, DELETING, AND RESTORING CHANNELS 

To mark or unmark a channel, click the left-mouse button on the channel ID or channel title, or use the 
space bar.   To mark groups of channels use the left mouse button to mark the first channel and the 
shift+left mouse button to mark the last channel.  Marked channels are displayed in red. 
 
To mark/unmark all analog and digital channels press the F8 key or select the “Mark/UnMark All” menu 
option under the “Channels” menu option.  If no channels are marked then all the analog and digital 
channels will be marked.  If any channels are marked, then all of the channels will be unmarked.  To 
mark/unmark all the analog channels select the “Analog Mark/Unmark All” menu option under the 
“Channels” menu.  To mark/unmark all the digital channels select the “Digital Mark/Unmark All” menu 
option under the “Channels” menu. 
 
Channels must be marked to delete them from the display.  The delete key removes the marked 
channels and the insert key restores the deleted channels. 
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SCALING ANALOG CHANNELS 

When the data display is initially opened, all the analog channels are scaled to one value.  To scale the 

channels according to the maximum space allocated for display, press F6 or click the AutoScale   
menu button.  This option toggles between the three views: On, Off and ++.  The active auto scale state 
is display in the AS status field.  Each view is defined below: 
 

• ON – The On view plots the channel data scaled to the maximum value allocated along the zero 
reference line. 

• OFF – The Off view plots the all channels scaled to one value.  

• ++ - The ++ view plots the signal using the number of maximum pixels allocated for the channel.  
The highest value is plotted at the maximum position and the smallest value is plotted at the 
lowest position.  This feature was added to clearly show the profile of frequency, Vdc and load 
data channels. 

 
The number of pixels allocated for each channel is displayed in the “PixsDisp” column in the analog 
information table. 
 
To increase or decrease a channel’s amplitude, along with the phasors and circular chart mark the 

channels and click the AmpUp  or AmpDn  menus buttons or use the ctrl+up and ctrl+down keys.  
The auto scale multiplier (ASM) is used to amplify or attenuation the channel’s data values.  For 
example, when the amplitude increases the ASM value is multiplied by the channel’s current “Pixsdisp” 
and when the amplitude decreases the ASM value is divided by the channel’s current “Pixsdisp”.  To 
change the ASM value, select the “Properties” menu option from the “File” menu then click the “Display 
Settings” tab.  Enter a number and click OK.  This value is initially defaulted to 2.00.  To 

increase/decrease only the analog channels amplitude, click the up and down arrow buttons  
located to the right of the data scroll bar. To increase/decrease only the phasor magnitude or circular 

chart click the up and down arrow buttons  located to the phasor/circular chart header.  
 

To increase or decrease the channel’s time scale, click the Condense  or Expand  menu buttons 
or press the ctrl+page up and ctrl+page down keys. 
 
NOTE:  If no channels are marked all the visible channels are scaled accordingly. 

ZOOMING CHANNELS 

To zoom in on analog or digital channels, mark the channels and press <enter> or click the ViewMrks 
 menu button.  The unmarked channels are removed from the Data Display. To restore the hidden 

channels press the <esc> key, the <backspace> key, or click the ViewAll  menu button. Refer to 
Figures 1.45 and 1.46. 
 
When returning to the original view all channels in the previous view remain marked for quick selection 
of additional channels for a new view. 
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Figure 1.45  Mark Analog Channels 

 

 

Figure 1.46  Show Marked Analog Channels 
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REPOSITIONING CHANNELS 

Analog channels can be repositioned in the Data Display.  To move a channel up one position mark the 
channel and press the “+” key or select “Shift Marks Up” from the “Channel” menu.  To move a channel 
down one position mark the channel and press the “-” key or select “Shift Marks Down” from the 
“Channel” menu. 

PRINTING WAVEFORM FILES 

To print all of the data for the visible channels, select “Print/All” from the File menu.  The page numbers 
are located on the top right corner of each printout.  The date and time of the first sample on each page 
is printed at the bottom left corner.  To print only the data currently displayed in the data window select 
“Print”/“Page” from the File menu.  Use the zoom feature to print only the selected channels.  An error 
message is displayed if the software cannot access the printer port. 

SAVING AS COMTRADE 

The visible analog and digital channels can be saved in COMTRADE ASCII or Binary format.  Currently 
there are two Comtrade versions supported: the older 1991 format and the newer 1999 format.  The 
Comtrade format is selected in the “Properties” dialog under the “Comtrade” tab. The default format is 
the newer 1999 format.  Mark the analog and digital channels to save and press <enter> or click the 
ViewMrks menu button . To create a COMTRADE file select the “Save as COMTRADE” (ASCII or 
Binary) option from the “File” menu. Enter the destination path and filename (do not define the filename 
extension) and click OK.  Refer to Figure 1.46. The “.DAT” and “.CFG” files are automatically created.  If 
a path is not defined, the COMTRADE files are saved in the active directory.  
 
To automatically name the Comtrade file using the IEEE long file naming convention check the “Use the 
ComNames Naming Convention to Name the Comtrade File(s)” field in the “Save As Comtrade” Dialog 
and leave the File Name field empty.  Refer to Figure 1.47.  The selected channels are converted to the 
selected Comtrade format and are named using the IEEE long file naming convention. 
 
If the sample values in the displayed file are RMS calibrated and the outcome Comtrade file must have 
instantaneous values then set the “Comtrade Settings” fields to automatically convert the RMS data to 
instantaneous values. To set the “Comtrade Settings” fields open the “Properties” dialog.  Select the 
“Comtrade” tab then select “Yes” for the “Convert RMS Calibrated Data to Peak Data”. 
 

 

Figure 1.47  Save As COMTRADE 

VIEWING ANALOG DATA 

The values displayed in the analog view can be presented in tabular form (analog table) or in a 

concentrated form (combination view).  Press F4 to toggle between the two views or use the View  
button (located to the right of the analog table headers) or the shift-right/left arrow keys to toggle 
through the analog table columns.  To close the analog table, click the close button located in the 
header. Valid analog channels are displayed in the left portion of the window and the analog information 
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in the right.  An analog channel is marked as invalid if the title is empty or it has the following strings in 
the beginning of the title. To show an invalid channel use the “Show/Hide Channel Title” dialog in the file 
manager. Refer to the “Show/Hide Channel Title” section for usage. 
 

• UNUSE 

• UNDEF 

• NOT D 

• NOT U 

• NOT I 

• NAT A 

• UNDEF 

• { 

• N/A 

• ANALOG INPUT 

• ANALOG CHANNEL 

• EXTERNAL INPUT 

• EVENT CHANNEL 

• CHANNEL 

• DIGITAL TRACE # 

• SPARE 
 
A maximum of 255 analog channels can be displayed in one window.  The values displayed in the 
analog table and combination view are described below. 
 
Analog Table View: 

The analog table view is the default view. Use the view button  or the shift-right/left arrow keys to 
navigate through the columns of the table. The original sample values are plotted according to one of 
the following data types: 
 

• Peak to Peak data  

• RMS Calibrated data  

• Log files.  
 
The display drivers in the system are all defaulted to peak to peak except for the predefined log drivers.  
To change the settings for a driver select the "Window Properties" option under the "File" menu.  Click 
on the "Driver Data Type" tab and select the type from the "Displayed Device’s Data Types" drop down 
list. Periodic Log File’s data type cannot be changed. 
 
 
The following tables describe the analog data for the sinusoidal peak-to-peak, non-sinusoidal, and 
sinusoidal RMS data types:  
 
Peak to Peak 

Field Description 

Title The analog channel titles. 

RMS The TrueRMS value is calculated by taking the summation of the square of 
all the sample values that lie between the RMS bar (black dotted line) and 
the data bar.  It then divides the result by the total number of samples 
between the two bars and takes the square root of the result. 

InstPeak The highest absolute value of all the samples between the two zero 
reference crossings surrounding the data bar (black solid line). 

Phase The phase angle of each channel. 

InstVal The sample value at the data bar (black solid line). 

RefVal The sample value at the reference bar (blue dotted line). 
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Field Description 

MaxPeak The maximum peak value of the channel. 

MinPeak The minimum peak value of the channel. 

Units The analog channels prefix and units. 

PixsDisp The number of pixels allocated for displaying the trace. 

DFT Peak The DFT Magnitude calculated between the RMS bar (black dotted line) 
and the data bar (solid data bar). 

Crest The DFTMag column divided by the RMS column. 

 
Sinusoidal RMS Calibrated 

Field Description 

Title The analog channel titles. 

RMS The RMSVal column calculates an RMS value for all the samples between 
the RMS bar (black dotted line) and the data bar (black solid line).  Since 
the data is RMS calibrated each sample value is multiplied by the square 
root of 2 before it is squared. 

InstPeak The square root of 2 times the peak value measured between the two 
reference crossings surrounding the data bar (black solid line). 

Phase The phase angle of each channel. 

InstVal The RMS sample value at the data bar (black solid line) times Root 2. 

RefVal The RMS sample value at the reference bar (blue dotted line) times Root 2. 

MaxPeak The RMS maximum peak value of the channel times Root 2. 

MinPeak The RMS minimum peak value of the channel times Root 2. 

Units The analog channels prefix and units. 

PixsDisp The number of pixels allocated for displaying each trace. 

DFT Peak The DFT Magnitude calculated between the RMS bar (black dotted line) 
and the data bar (solid data bar). 

Crest The DFTMag column divided by the RMS column. 

        
Non-Sinusoidal (Log Files) 

Field Description 

Title The analog channel titles. 

MaxWin The absolute maximum value between the sliding window bar (black dotted 
line) and the data bar (black solid line). 

InstVal The sample value at the data bar (black solid line). 

RefVal The sample value at the reference bar (blue dotted line). 

MaxVal The maximum value of the channel. 

MinVal The minimum value of the channel. 

Units The analog channels prefix and units. 

PixsDisp The number of pixels allocated for displaying the trace. 

AvgWin The average value of all the samples between the sliding window bar (black 
dotted line) and the data bar (black solid line) 

   
Combination View: 
The combination view shows all the channel information in a signal view. This view is only available if 
there is enough room between analog channels to display three lines of text. 
 
Default Display format: 
 
Peak to Peak: 

Channel Title    

RMS MaxPeak RefVal  

InstVal MinPeak Units ASV 
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RMS Calibrated:  

Channel Title    

RMS MaxPeak RefVal  

InstVal MinPeak Units ASV 

      
Load Files: 

Channel Title    

MaxWin MaxVal RefVal  

InstVal MinVal Units ASV 

 
The peak sample values are displayed in red when the data bar is on the channel’s maximum value and 
displayed in blue when the data bar is on the minimum value. Use the tab key to toggle between the 
analog and digital channels. To hide the channel information, select "Channel Information" from the 
"View" menu. 
 
The analog table and combination views can be resized by selecting the vertical separator bar and 
dragging it to the right or left. The cursor changes to the vertical resize cursor when the mouse is 
positioned over the separator bar.  
 
To change how the analog data is displayed in the analog table and combination view select 
"Properties" menu option from the "File" menu. The “Properties” dialog allows for reordering, hiding, and 
showing the analog table columns; changing the data positions in the combination view; changing the 
background colors and trace colors; and for changing the drivers data type and trace/phasor scale 
multipliers plus more.  

VIEWING DIGITAL DATA 

The default digital view consists of only the triggered digital channels, which are displayed at the bottom 
of the screen. To view all the digital channels including the unused channels press F9 or select “All 
Digital Channels” from the “View” menu.   
 
The digital trace is displayed as a thin black line when the sample value equals the original state defined 
in the displayed format and displayed as a thick green line when the sample value is different than the 
original state. The cursor state column in the digital table displays an “A” for Alarm and “N” for Normal.  
They are set by comparing the sample value at the data bar with original state, “A” = different then 
original state, “N” = same as original state.   
 
The Digital information is displayed in tabular form. The data columns are described below: 
 

Column Number Description 

1 – Cursor State The digital state of the sample at the cursor position (A=Alarm, N=Normal).  

2 – Title The channel title, a maximum of 40 characters can be displayed.  

3 – Fst The digital state of the first sample (A=Alarm, N=Normal).  

4 – Lst The digital state of the last sample (A=Alarm, N=Normal).  

5 – Fst-Change The time the channel first changed state.  

6 – Lst-Change The time the channel last changed state.  

7 – Changes The number of times the channel-changed state.  

 
Use the scroll bar or the up and down arrow keys to navigate through the channels and the tab key to 
toggle between the analog and digital views. 

CUSTOMIZING THE DATA DISPLAY 

The “Properties” option in the “File” menu allows for customizing the data display window. Below is a 
description of each tab defined: 
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• Analog Table – The analog table tab is used to reorder, hide and show the columns in the 
analog table.  

• Analog Combination – The analog combination tab is used to change the position of the data 
values in the combination view.  

• Comtrade – The Comtrade tab is used to define the Comtrade format for saving, the date and 
time format for display and to set automatic conversion from RMS data to Peak data when using 
the “Save As Comtrade” feature.  

• Colors – The colors tab is used to define the background colors of each display section and to 
set the default analog channel colors.  

• Values File – The values file tab is used to define the values file and general information used 
when saving samples values to a file.  

• Display Settings – The display settings tab is used to define the ASM scale multiplier for the 
traces and phasor/circular chart scaling, and to define general display information for the 
window such as: setting the display trace type (sample based or time based), showing the time 
reference bar between the analog channels and the digital channels, showing the separator bar 
between multiple events displayed in one window, showing or hiding the fault bar (red dotted 
vertical bar) and for defining the option to reference angles across windows when Sync mode is 
active.  When “Yes” is defined all phase angles for the currently opened windows will be 
referenced off the 1

st
 marked channel in the active window.  

• Append / Merge – The append/merge tab is used to define which file the samples will be 
discarded from when the append/discard common times option is used.  It is also used to define 
if the station name should be added to the analog/digital titles when an append/merge option is 
executed.  

• Driver Data Type – The driver date type tab is used to define the type of date that is saved to 
the displayed device’s data file: RMS Calibrated Type or Peak Type.  

• Filters – The filters tab is used to define if spikes detected in the data file should be ignored 
when the maximum and minimum values are calculated and at what level they should be 
ignored.  

TIME & SAMPLE BASED DISPLAYS 

The “Trace Display Type” field located in the “Display Settings” tab of the “Properties” dialog allows for 
toggling between the “Time Based” display and the “Sample Based” display. The sample base display 
plots the channel data with 1 pixel distance between each displayed sample. Sample based displays 
are useful for showing changes in sampling frequency. The time base display plots the channel data in 
time.  Time base displays are useful for showing changes in line frequency. 
 
To change the trace display type open the “Properties” dialog under the “File” menu. Click the “Display 
Settings” tab and change the “Trace Display Type” field to time based or sample based. 

FAULT REFERENCE TIME BAR 

The fault reference time bar is displayed between the analog and the digital traces. It displays the time 
difference from the fault time defined in the displayed file. The units are displayed in the Delta X status 
field. 
 
To show or hide the fault reference time bar open the “Properties” dialog under the “File” menu. Click 
the “Display Settings” tab and select “Yes” or “No” for the “Show Reference Time Bar” field. 

SUPERIMPOSING ANALOG CHANNELS 

To superimpose two or more analog channels, mark the channels and press F7 or select “Super 
Impose” from the “Data” menu. The marked channels are superimposed and placed at the top of the 
display.  If no channels are marked, all channels are superimposed. Press F7 to turn this feature 
ON/OFF. 
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CHANGING ANALOG CHANNEL COLORS 

To change the color of an analog channel, click the right mouse button on the channel ID. Select the 
channel color from the list or click “More Colors” to select from the color palette. Channels must be 
unmarked to change their colors. 

SYNCHRONIZING DATA CURSORS 

The Sync Data Cursors feature is used to synchronize the data bars for two or more display windows.  
Refer to Figure 1.48. To synchronize two or more data bars, open the files, select “Tile Horizontal” from 
the Windows menu, and select “Sync Data Cursors” from the “Data” menu. This feature offers two sync 
functions:  “By Time” and “Manually”. When a function is selected, the data bars in the non-active 
windows are moved to the synchronization point of the active window. The two functions are described 
below: 
 

By Time 
When the time function is activated, the data bars in the non-active windows are moved to the 
sample time of the data bar in the active window. For example if the data bar in the active window is 
positioned on a sample at time 01:12:34.5600 then all the non-active data bars are moved to the 
sample at that time. If the time cannot be found the data bar does not move. 
 
Manually 
The manual sync function allows for the selection of different cursor positions in the windows before 
synchronization is activated. For example, open four display windows and tile horizontally. Move the 
data bar to the beginning of the fault cycle in each window and select the Manual cursor sync 
function. Press the left arrow, right arrow, ctrl+left, ctrl+right, page up, page down, ctrl+page up, 
ctrl+page down, home and end keys or use the scrollbar to move the data bars. 
 
 

 

Figure 1.48  Cursor Synchronization 

 
In Sync Mode phase angles can be referenced across data display windows. The phase angles in the 
opened data windows are referenced by the 1st marked channel in the active data window. This feature 
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is activated from the “Properties” dialog under the "Display Setting" tab in the Sync Mode section. Sync 
Mode must be active for the angles to be referenced. 

APPEND OPEN FILES 

The “Append Open Files” option under the “File” menu appends all the open windows into a new display 
window. There are two options available under the Append Open Files Menu: 

• Discard Common Times: Any common times found in the open files will be deleted from the 
oldest file. 

• Back to Back: The files are appended back to back. No samples are deleted. 

MERGE OPEN FILES 

The “Merge Open Files” option under the “File” menu merges all the displayed or marked channels into 
one display window. There are three options available under the Merge Open Files Menu: 
 

• By Time:  Merge channel samples if they have a common time segment.  The reference time is 
from the file with latest start date and time.  The file with the least amount of samples 
determines the length of the new merged file. Refer to Figure 1.51 & 1.52. 

• Manually:  Use the data bars to highlight where the common sample time is in each window.  
Merge manually will then line up the data bars and adjust the time stamps accordingly. This 
option is used when the file times are not synchronized.  The active window determines the time 
stamp of the new merged file and the open window with the smallest number of samples 
determines the length of the new merged file.  Refer to Figure 1.53 & 1.54. 

• By Sample:  Merge regardless of time stamps and/or data bar positions.  The reference time is 
from the active window.  And the file with the least amount of samples determines the length of 
the file.  Refer to Figure 1.55. 

 
When files with different sampling frequencies are merged a dialog will be displayed. The dialog 
contains a list of all the sampling frequencies in the opened files. Select the frequency for the merged 
file or enter a new frequency.  Refer to Figure 1.49. 
 

 

Figure 1.49  Merge Open Files: Select Frequency 
 
Merging Open Files allows for flexibility of what channels are merged.  “Merge Open Files” will merge 
either the marked channels only or if there are no marked channels then it will merge the visible 
channels. 
 
If the merged files have different data types (RMS Calibrated or Peak Values) then the RMS values will 
be converted to Peak values by multiplying the RMS values by Root 2. 
 
To identify the merged channels the station name for each file is added to the beginning of the analog 

and digital channel names. To turn this feature off open the “Properties” dialog .  Click on the 



Chapter 1 - Quick Start 

 

50  

Append/Merge tab and uncheck the “Add the File’s Station Name to Beginning of the Analog/Digital 
Channels” field.  Refer to Figure 1.50. 
 

 

Figure 1.50  Append/Merge Properties 
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Figure 1.51  Merge Open Files – By Time: Open files and select channels to Merge 
 

 

Figure 1.52  Merge Open Files – By Time: Result: By Time 

 
Merge Open Files “By Time” will only merge the samples with common times. The reference time is the 
file with the latest start date and time. 
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Figure 1.53  Merge Open Files – Manually: Select Channels & Position Data Bars 
 
First select the channels to merge by marking the channels and pressing the <enter> key. Next position 
the data bars at what should be the Same Point in time. 
 

 

Figure 1.54  Merge Open Files – Result: Manually 
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Merge Open Files “Manually” is used when the file times are not synchronized. Place the data bars in 
the position where the times should be synced and merge the files. Merge will line up the samples 
according to the position of the data bar in each open file. The data bar with the least amount of 
samples to the beginning determines the number of samples to truncate from the beginning of all other 
open files. The active window’s time stamp is used for the merged file and the open file with the least 
amount of samples determines the length of the merged file. 
 

 

Figure 1.55  Merge Open Files – Result: By Sample (As Applied to Figure 1.51) 
 
Merge Open Files “By Sample” merges regardless of time stamps and/or data bar positions.  It merges 
“As Is”.  The reference time is from the active window.  And the file with the least amount of samples 
determines the length of the file. 

CHANGE FREQUENCY 

Change Frequency changes the current sampling frequency to the entered frequency. Refer to Figure 
1.56. If the entered frequency is greater than the current frequency, then samples are added. If the 
entered frequency is less than then the current frequency, then samples are deleted. Refer to Figure 
1.57 & 1.58 for an example that sets a multiple frequency file to a single frequency. The entered 
frequency must be greater than 2 times the line frequency. 
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Figure 1.56  Change Frequency Dialog 

 
It also allows for defaulting a driver to always display its’ files in the entered frequency.   
NOTE:  If Open Frequency is checked then the Restore Original is not available. 
 

 

Figure 1.57  Change Frequency: Change a Mutiple Frequency File to One Frequency 
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Figure 1.58  Change Frequency: Results 

TRUNCATE CYCLES 

Truncate Cycles removes the specified number of cycles from the data display. Refer to Figures 1.59 & 
1.60. There are three options available under the Truncate Cycles menu option. 

• Left: Remove all cycles from the 1
st
 sample to the data bar.  

• Right: Remove all cycles from the data bar to the last sample. 

• Middle: Remove all cycles from the data bar to the reference bar (blue dotted line). 
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Figure 1.59  Truncate Cycles: Append Non Time Matching Waveforms 
 
After Appending two waveform files it may be necessary to truncate the cycle that did not match up.  
First line up the reference bar on the peak before the appended position then line up the data bar on the 
peak after the appended position and select the truncate middle menu option. 
 

 

Figure 1.60  Truncate Cycles: Results 
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DUPLICATE CYCLES 

Duplicate Cycles duplicates the cycle at the data bar by the number of times entered in the Duplicate 
Cycles Dialog. Refer to Figure 1.61. This feature is useful for creating Comtrade files to play back to test 
set applications and for modeling and simulation applications. Refer to Figures 1.62 & 1.63 for an 
example that adds 5 cycles of fault cycles to a file. 
 

 

Figure 1.61  Duplicate Cycles Dialog 
 

 

Figure 1.62  Duplicate Cycles: Initial File 
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Figure 1.63  Duplicate Cycles: Results 

RESTORE ORIGINAL DATA 

Restore original data will reread and display the sample values from the active waveform file on disk.  
Any changes made to the data display window, such as: duplicate cycles, change frequency and 
truncate cycles will be lost when this feature is activated. If the “Open Frequency” option is checked in 
the “Change Frequency” dialog then the Restore Original Data is not available.  

MARK RAW VALUES 

Mark Raw Values marks the raw samples saved in the active waveform file on disk. A small hollow blue 
circle is placed at the raw sample. This feature is helpful in highlighting the raw sample values saved in 
low sampling rate files. Refer to Figure 1.64. 
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Figure 1.64  Mark Raw Values 

MARK PEAK VALUES 

Mark Peak Values marks the peak sample values for all visible analog traces. A small solid gray square 
is placed at the peak values. Refer to Figure 1.65. This feature is helpful in highlighting the positive and 
negative peak values.  
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Figure 1.65  Mark Peak Values 

MARK CHANGE IN SIGN VALUES 

Mark change in sign marks the all samples where a change in sign occurs. A small solid gray triangle is 
placed at the change position. Refer to Figure 1.66. This feature is helpful in highlighting the position 
where a change in sign occurs.  
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Figure 1.66  Mark Change in Sign 

CHANGE ANALOG VALUES (PRIMARY ��������  SECONDARY) 

The values displayed in the analog table are either in primary or secondary quantities. If the file defines 
the type of values saved then the type is displayed in the window header. Refer to Figure 1.67. Also, if 
the CT and PT ratios are defined in the configuration file then the values can be changed from primary 
to secondary and vice versa. To change the values open the properties dialog and click on the “Driver 
Data Type” tab, select the Primary or Secondary radio button to switch between values. Refer to Figure 
1.68. 
 

 

Figure 1.67  Type of Analog Values Displayed 
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Figure 1.68  Change Analog Values (Primary �������� Secondary) 
 
The CT and PT ratio values can be viewed by clicking on the “View Ratio Values” button in the “Driver 
Data Type” tab. The values are listed in a table format for each analog channel. Refer to Figure 1.69. 
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Figure 1.69  Ratio Values 

ADJUST FILES TIME 

The Adjust Files Time allows for adjusting the time of the open file. To open the “Adjust File Time” dialog 
select the "Adjust Files Time" menu option under the "Data" menu. You can specify to add or subtract a 
give time increment from the files current time. Enter the desired time increment for the hour, minutes, 
seconds and milliseconds. If there is no adjust needed on a specific time field enter 0. Refer to Figure 
1.70. 
 

 

Figure 1.70  Adjust Files Time 
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To always have the file's time automatically adjusted when a specific driver is used to open a file check 
the "Adjust Open Time" check box. 
 

To show the file’s original date and time click on the “Restore Original” button  or select the “Restore 
Original Data” menu option under the “Data” menu. 

CREATING VIRTUAL CHANNELS 

The data display window allows for six software analog channels (SAC) and eight software digital 
channels (SDC).  These additional channels are virtual channels that exist only in RAM.  The sample 
values are created using a function of the existing analog/digital channels.  Predefined operators can be 
used to calculate a missing phase, create positive/negative and zero sequence channels; convert 
channels to secondary or primary values; calculate the resistance of V/I, multiply, divide, add and 
subtract multiple channels; multiply, divide, add and subtract channel data by a constant value; create 
an envelope of an analog channel; define over-trigger or under-trigger values; calculate a missing 
phase; define the prefix and unit for the channel; or perform bit-wise ANDing/ORing on digital traces. 
 
All calculations are designed to operate "on the fly".  For the forward looking SAC operator ("@" some 
positive angle) care must be taken.  Upon opening a file and while the system is reading the data 
samples, the forward samples are not available. In that case the system will use the current sample 
instead of the requested forward sample.  To execute forward looking SAC instructions, wait until the file 
is read then use F5 to recalculate. 

 
The SAC and SDC instructions are composed of an operator and an operand.  An operand can be a 
channel defined by the channel number or a constant.  Constant values must have a “^” operator before 
each value to distinguish between channel numbers and constant values.  To phase shift analog 
channels, use the “@” sign before each angle defined.  All angles must be defined in degrees.  Below is 
a list of all the software operators that are available: 
 

• “+” - Add (Analog)  

• “-“ - Subtract (Analog)  

• “*” - Multiply (Analog)  

• “:” - Divide (Analog)  

• “^” - Constant value (Analog)  

• “@” - Angle in degrees (Analog)  

• “e” - Half cycle envelope (Analog)  

• “a” - Envelope (Analog)  

• “<” - Under-trigger (Analog)  

• “>” - Over-trigger (Analog)  

• “h” - Harmonic for Channel 

• “h=” - Harmonic for all Back Operations  

• “|” - Absolute Value 

• “p=” - Prefix (Analog)  

• “u=” - Unit (Analog)  

• “+” - And (Digital)  

• “.” - Or (Digital)  

• “/” - Instruction terminator (Analog & Digital)  
 
NOTE: All SAC/SDC operations are performed in reverse polish notation (one operation at a time). 

The instruction set must always terminate with a “/”.  An operation error is generated if the 
instruction formats are not followed.   
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Press F5 to display the SAC dialog or select “Software Analog Channels” from the Channel menu.  
Refer to Figure 1.71.  To display the SDC dialog select “Software Digital Channels” from the Channel 
menu.  Below are a few examples: 
 

Operations Example Description 

Addition +7/+8/+9/ Add channels 7, 8, & 9 and store the result in 
the SAC. 

Subtraction +7/-8/-9/ Subtract channel 8 from channel 7, and store 
the result in the SAC then subtract channel 9 
from the SAC and restore the values in the 
SAC. 

+ Sequence +1/+2@120/+3@240/:^3/p=k/u=volt/ Calculate the + sequence components and 
store the result in the SAC then set the SAC’s 
prefix and unit. 

- Sequence +1/+2@240/+3@120/:^3/p=k/u=volt/ Calculate the - sequence components and 
store the result in the SAC then set the SAC’s 
prefix and unit. 

0 Sequence +1/+2/+3/:^3/p=k/u=volt/ Calculate the zero sequence components and 
store the result in the SAC then set the SAC’s 
prefix and unit. 

Harmonics +16/h=1/p=k/u=volt/ Extract the 1
st
  Harmonic component from 

Channel 16 and store in the SAC then set the 
SAC’s prefix and unit. 

Multiplication +3/*^2.66/ Multiply all sample values in channel 3 with 
the constant value 2.66 and store the result in 
the SAC. 

Division +7/:3/ Divide all sample values in channel 7 by the 
sample values in channel 3 and store the 
result in the SAC. 

Half Cycle 
Envelope 

+2/e/ Calculate the half cycle envelope of channel 2 
and store the result in the SAC. 

Envelope +12/a/ Calculate the envelope of channel 12 and 
store the result in the SAC. 

Under-trigger +4/<135/ Store all the sample values from channel 4 
that are < 135 in the SAC. 

Over-trigger +62/>500/ Store all the sample values from channel 62 
that are > 500 in the SAC. 

Absolute 
Value 

+7/+8/+9/|/p=k/u=Volts/ Add channels 7, 8, & 9 and store the absolute 
value of the result in the SAC then set the 
SAC’s prefix and unit. 

AND +2/.33/ AND channel 2 with channel 33 and store the 
result in the SAC.  The “.” represents the AND 
operation. 

OR +2/.4/+14/ AND channel 2 with 4, then OR the result with 
channel 14 and store the result in the SAC.  
The “+” sign represents the OR operation. 
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Figure 1.71  SAC Dialog 
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Figure 1.72  SAC Results  
 
Engineers can use the additional channels as a generic tool for monitoring or modeling tasks.  A virtual 
channel can be used to compute one of the phases of a monitored line by adding the remaining phases 
then subtracting the result from the residual channel.  This in turn frees up a hardware channel for other 
monitoring needs. 

PLAY CHANNELS AUDIO 

It is now possible to hear the characteristics of a signal through the data display window. To play the 
audio of a specific analog channel first mark the channel then open the “Analog Channel Audio” dialog 
by selecting the “Play Channels Audio” menu option under the “Data” menu. The Analog Channel Audio 
dialog is displayed in the bottom right hand corner of the data display window. Refer to Figure 1.73. 
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Figure 1.73  Play Audio Dialog   
 
The “Active Channel” section displays the analog channel marked in the data display window. The 
“Audio Controls” section allows for playing the active analog channel’s data through the computers 
speakers and for increasing/decreasing the volume of the output. The “Save .WAV File” section allows 

for saving the analog channel data in the Window’s .WAV format. Click the folder button  to select 
and destination directory and to enter a new “.WAV” file or for selecting an existing “.WAV” file. The 
selected file path and name will be updated in the “Audio Filename” field. 
 
To view the saved “.WAV” file exit the data plotting window, navigate to the “.WAV” file path and double 
click on the wave file. A new display driver has been added to plot Microsoft’s “.WAV” files.  

ALIGN CHANNEL DATA 

The “Align Channel Data” option will align the analog channel samples according to the defined phase 
shift angles. The alignment routines use the Thiran 3

rd
 Order All Pass Fractional filter. The all-pass 

delay guarantees no magnitude deterioration and fractional because delays can be a fraction of the 
sample interval. 
 
To align the analog channels manually open the “Align Channel Data” by selecting the menu option 
under the “Channel” menu. If the Thiran filter has already been applied to the displayed analog channels 
a message is displayed. Refer to Figure 1.74. 
 

 

Figure 1.74  Align Channel Message   
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To continue to the “Align Channel Data” dialog click “Yes”. To apply the filter to the file’s original 
unfiltered data click “No” or “Cancel” then select the “Restore Original Data” menu option under the 

“Data” menu or click on the “Restore Original” menu button.  
 
The “Align Channel Data” dialog will apply the Thiran filter according to the entered Phase Shift angles. 
Enter the phase shift angle for each analog channel. Refer to Figure 1.75. If the filter does not apply to a 
specific analog channel enter 0 or leave the field blank or enter NONE. To display the coefficient values 
used for each analog channel click the “Calculate Coefficients” button. The “A0, A1, A2 and A3” fields 
will be updated with the coefficients for the entered phase shift angles.   
 

 

Figure 1.75  Align Channel Data Dialog   

 
To always apply the Thiran filter on files for the active driver click the “Always Apply” check box. Always 
apply will automatically run the Thiran filter with the defined phase shift angles before displaying the file. 

To display the files original samples click the “Restore Original” menu button  or select the 
“Restore Original Data” menu option under the “Data” menu. 
 
The coefficients used for the filter can be edited. If the coefficients are modified click the “Use Entered 
Coefficients Values” radio button. To have the coefficients automatically calculated when the filter is 
applied click the “Calculate Coefficients at Run” radio button.  
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USER VIEWS 

User Views allow for saving and displaying specific information about a selected view. When a view is 
saved the following information is saved to an ASCII text file in the user defined folder. 
 

• Displayed analog channels, 

• Analog channel order, 

• Superimposed channels, 

• Analog channel colors, 

• Digital channels displayed, 

• Sampling frequency, 

• Time scale, 

• Sliding window size (RMS bar to Data bar), 

• Phasor window size, 

• Table window size, 

• Red fault bar, 

• Auto scale and 

• Phasor or circular chart displayed 
 
To save a view first setup the desired view then select the “Save View” menu option under the “View” 
menu. The “Save View” dialog is displayed. Refer to Figure 1.76. 
 

 

Figure 1.76  Save View Dialog 
 
Enter the view’s name in the “View Name” field and select or enter the destination path into the “View 
File Path” field. By selecting the destination folder a hierarchy of views can be saved that allows for easy 
access to specific views according to the users preference.  
 
To select a view open the view drop down menu. Refer to Figure 1.77. The drop down menu list the last 
7 saved/selected views. If the view is not listed click on the “More View” option to open Microsoft’s 
select file dialog. Refer to Figure 1.78. Navigate to the view’s folder and double click on the view file.  
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Figure 1.77  Select View Drop Down Menu 

 

 

Figure 1.78  Select View File Dialog 
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To view the details of a saved view before selecting it, open the “Select View” dialog from the “View” 
menu. Refer to Figure 1.79. The select view dialog has 3 sections. On the left side of the dialog is the 
list of all the available views located in the displayed view path. To change the view path either use the 
browse button or select a previous navigated directory from the “View Path” drop down list. On the right 
side is the view information for each analog channel and digital channel in the view. 
 

Figure 1.79  Select View Details Dialog 
 
Double click on the view file or select the file and click “OK”. If the analog channel and digital channel 
names defined in the view file are not in the displayed file than an error message is displayed. To exit 
the dialog without selecting a view, click on the “Cancel” button. 
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C H A P T E R  2  

System Requirements & Installation 
 
This chapter lists the system requirements needed for installing and running the Wavewin software.  It 
also describes the installation procedures and provides technical support information. 

System Requirements 

The system requirements are listed below. 

 
An IBM or compatible PC with an 80486 microprocessor or higher. 
128 Megabytes of memory. 
2 gigabytes of available hard disk space. 
A VGA, 8514/A, or compatible graphics adapter. 
Microsoft Windows version 98 or higher. 

Installation 

The system files are distributed in a compressed format.  To install the software follow the instruction for 
the type of storage media distributed with this manual. 
 
Web: To install the software from the web open the www.wavewin.net web site. Under the “Wavewin 
Upgrades” link click on the Wavewin application to download. Enter your username and password. The 
username & password are case sensitive. Click on the application link to download the system’s 
executable files. Open the zip file and run the install.  
 
CD: To install the software using a CD place the CD into the CD drive.  The installation program will run 
automatically. If the installation program is not displayed then navigate to the CD’s root drive and double 
click on the install.exe application. 
 
Follow the following instructions to fully install the software. 
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Figure 2.1  Destination Folder 
 
Define the destination folder for the system files then click Next to start the installation.  
 
The destination folder is the folder where all files are to be copied. Use the browse button to select and 
existing directory.
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Figure 2.2  Finish Install 
 
The install is now complete click Finish to end the installation. 

Starting the Software 

After you have installed the software on your computer, you are ready to get started.  The way you begin 
depends on your own style.  If you like to dive right in and learn by doing the system provides on-line help 
to assist you.  If you prefer a structured learning approach, read the previous chapter to get familiar with 
the software features. 

 
To run the software, click on the installed desktop icon or open the Start menu, navigate to the installed 
Program folder and click on the Wavewin32 shortcut. 

   

Technical Support 

Although this system is easy to use and understand, at some point you may encounter a technical 
question, feel that the system has improperly operated, or have suggestions for future improvements.  In 
either case, contact Softstuf using one of the following methods: 
 
Phone:  215-922-6880, hours are from 9:00 a.m. to 8:00 p.m. Mon- Fri, (EST). 
Fax:  215-625-2497, response time is 24 hours.  
E-mail:  support@softstuf.com, response time 24 hours. 
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C H A P T E R  3  

Fields & Features 
 
This chapter describes all the fields and features available in the software.  They are listed alphabetically 
for your convenience.  

ACTIVE TOPIC - HELP 

Location: All child windows 
 
Description: Display the active windows Help file. 
 
Activation: Menu: Alt-H, T 

ADJUST FILES TIME 

Location: Data Display 
 
Description: The Adjust Files Time allows for adjusting the time of the open file. To open the “Adjust 

File Time” dialog select the "Adjust Files Time" menu option under the "Data" menu. You 
can specify to add or subtract a give time increment from the files current time. Enter the 
desired time increment for the hour, minutes, seconds and milliseconds. If there is no 
adjust needed on a specific time field enter 0. 

 
Activation: Menu: Alt-D, J 
 
Comments: To always have the file's time automatically adjusted when a specific driver is used to 

open a file check the "Adjust Open Time" check box. To show the file’s original date and 

time click on the “Restore Original” button  or select the “Restore Original Data” menu 
option under the “Data” menu 

 
See Also: Adjust Files Time in Chapter 1 

ALIGN CHANNEL DATA 

Location: Data Display 
 
Description: The Align Channel Data option allows for aligning the channel data using the Thiran 3

rd
 

Order All-Pass Fractional filter. To open the “Align Channel Data” dialog select the "Align 
Channel Data" menu option under the "Channel" menu. Enter the phase shift for each 
analog channel. Enter 0 or leave the field blank if the filter does not apply to a specific 
analog channel. Click the “Run Thiran Filter” to apply the filter. 

 
Activation: Menu: Alt-C, T 
 
Fields: Phase Shift:  The phase shift angle for each analog channel. 

A0:   The Thiran A0 coefficient for each analog channel. 
A1:   The Thiran A1 coefficient for each analog channel. 
A2:   The Thiran A2 coefficient for each analog channel. 
A3:   The Thiran A3 coefficient for each analog channel. 
Always Apply:  Always apply the filter when opening files for the active driver. 
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Coefficients:  Calculate coefficients at run or use the entered coefficients. 
 
Options: Calculate Coefficients: Calculate the Thiran coefficients for each analog channel. 

Run Thiran Filter: Run the Thiran filter. 
Esc/Cancel:  Exit the dialog without executing the command. 

 
Comments: To always have the filter automatically applied when a specific driver is used to open a 

file check the "Always Apply" check box. To show the file’s original date and time click on 

the “Restore Original” button  or select the “Restore Original Data” menu option under 
the “Data” menu. 

 
See Also: Align Channel Data in Chapter 1 

ANALOG MARK/UNMARK ALL 

Location: Data Display 
 
Description: Marked all analog channels if there are no analog channels marked else unmark all the 

marked channels. 
 
Activation: Menu: Alt-C, N 
 
Comments: The channels ID and titles are displayed in light red when marked.  Press F8 to mark or 

unmark all the analog and digital channels. 

ANALOG TABLE VIEW  

Location: Data Display 
 
Description: Displays the channel titles, ASV, units, and associated data values. 
 

Comments: Use the  button or the shift-right/left arrow keys to scroll the columns in the table.  This 
button is located to the right of the analog table headers. 

 
See Also: Viewing Analog Data in Chapter 1. 

APPEND LOGS 

Location: File Manager 
 
Description: Combine a number of log files (ABB Load Profile, Comtrade Logs and SDC Logs), of the 

same types (the columns match), into one comma delimited file with the extension .CSV.    
 
Activation: Menu: Alt-O, R, A 
 
Comments: The files must be of the same type (columns must be equal and data extracted from the 

same device).  The save file can be displayed in a table or plotted in the log data viewer. 
 
See Also: Combine Logs 

APPEND OPEN FILES 

Location: Data Display 
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Description: Combine a number of open files of the same types (the analog/digital channel titles must 

match) in time.  All of the currently open waveform files will be appended into a new data 
display window. 

 
Activation: Menu: Alt-F, F, D (Append the open files by Discarding the common times) 

Menu: Alt-F, F, B (Append the open files Back-to-Back) 
 
Comments: The files must be of the same type (the analog/digital channel titles must match).  The 

results in the new data display window can be saved in a Comtrade file for archiving. 
 
See Also: Append Waveform Files 

Append Open Files in Chapter 1 

APPEND WAVEFORM FILES 

Location: File Manager 
 
Description: Combine a number of waveform files of the same types (the analog/digital channel titles 

must match) in time into a data display window. 
 
Activation: Menu: Alt-O, W, A, D (Append waveform files by Discarding the common times) 

Menu: Alt-O, W, A, B (Append waveform files Back-to-Back) 
 
Comments: The files must be of the same type (the analog/digital channel titles must match).  The 

results in the data display window can be saved in a Comtrade file for archiving. 
 
See Also: Append Open Files 

Append Waveform Files in Chapter 1 

ASCENDING SORT 

Location: All Tables 
 
Description: Sort the table columns in ascending order with respect to the selected sort field.   
 

Activation: Direct: Column Header  
Menu: Alt-S, A 

 
Comments: To change the sort field, place the cursor in the desired column and select “Set Sort 

Field” in the Sort menu.  The sort field is displayed in the status bar at the bottom of the 
window.  To sort column data directly press the column header button.  The sort field in 
the status bar is automatically updated.  The header buttons toggle between ascending 
and descending order.  The current sort order is displayed in the active sort column 
header as an up triangle for ascending and as a down triangle for descending. 

 
See Also: Descending Sort  

Sorting Files in Chapter 1 

ASCII DRIVER 

Location: File Manager 
 
Description: Display the file at the cursor position in the ASCII text editor. 
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Activation: Menu: Alt-D, 1 
 
See Also: ASCII Editor 

ASCII EDITOR 

Location: File Manager 
 
Description: Edit the ASCII file at the cursor position.  
 
Activation: Direct: F2 

Menu: Alt-O, A 
 
Comments: The file content is displayed in text format.  Use the up arrow, down arrow, left arrow, 

right arrow, page up, page down, home, end, Ctrl-home and Ctrl-end keys or the scroll 
bar to navigate through the data and the Edit menu options to cut, copy, or paste text.  A 
maximum of 10 ASCII Editors can be opened simultaneously.  

AS STATUS FIELD 

Location: Data Display (Status Bar)  
 
Description: Displays the current state of the Auto Scaling feature (ON, OFF or ++). 
 
Comments: To toggle through the Auto Scaling options (ON, OFF or ++), press F6 or select “Auto 

Scale” from the Options menu.  When auto scaling is turned “ON”, the channel data is 
scaled to the maximum value allocated for display from the zero reference line.  When 
auto scaling is in the “++” state the signals are plotted using the maximum value allocated 
for display, ignoring the zero reference line.  The highest value is plotted at the maximum 
position and the smallest value is plotted at the lowest position.  This feature was added 
to clearly show the profile of frequency, Vdc and load channels.  In the “OFF” state all 
channels are scaled to one value. 

 
See Also: ASV Column 

Auto Scaling 

ATFILE  

Location: File Manager (Status Field)  
 
Description: Displays the file number of the selected file in the table. 

AUDIO WAVE DRIVER 

Location: File Manager 
 
Description: Change the driver at the cursor position to the Window’s Audio Wave driver (*.WAV) and 

plot the input channels. 
 
Activation: Menu: Alt-D, W 
 
Comments: All files that have a “.WAV” extension are tagged as Microsoft Audio Wave files.   
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AUTO DETECT DRIVER 

Location: File Manager 
 
Description: Infers the filename at the cursor position and activates the associated driver. 
 
See Also: Associating File Types in Chapter 1. 

AUTO SCALING 

Location: Data Display 
 
Description: Turn the state of amplitude auto scaling On, Off or to ++ for all the visible analog 

channels. 
 

Activation: Direct: F6 - ASV menu button  
Menu: Alt-D, A, F-Off, O-On and P-Plus 

 
Comments: The AS field displayed in the status bar indicates the auto scale’s current state, ON, OFF 

or ++.  When auto scaling is turned “ON”, the channel data is scaled to the maximum 
value allocated for display from the zero reference line.  When auto scaling is in the “++” 
state the signals are plotted using the maximum value allocated for display, ignoring the 
zero reference line.  The highest value is plotted at the maximum position and the 
smallest value is plotted at the lowest position.  This feature was added to clearly show 
the profile of frequency, Vdc and load channels.  In the “OFF” state all channels are 
scaled to one value. 

 
See Also: Increase Amplitude 

Decrease Amplitude 
Auto Scale Multiplier 
AS Status Field 

BACKGROUND COLOR 

Location: DXF Display (Drawing Constants Dialog)  
 
Description: Select the background color of the DXF drawing. 
 
Activation: Direct: F2 

Menu: Alt-F, D 
 
Default: Black 

CALIBRATION REPORT 

Location: File Manager 
 
Description: Generate a calibration report for all marked event files. 
 
Activation: Menu: Alt-O, R, C 
 
Comments: The calibration report runs a series of equations on the input analog data to determine if 

a channel needs to be calibrated.  An analog channel is displayed in the report if one or 
more of the following equations are true: 
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The HP-Dif is greater than 2.5 times the OneBit value. 
The LP-Dif is greater than 2.5 times the OneBit value. 
The difference between the HPeak-Up and LPeak-Up is > 2.5 x's the OneBit. 
The difference between the HPeak-Dn and LPeak-Dn is > 2.5 x's the OneBit. 

 
For this feature to work properly reports should be generated on non-fault data.  The 
DVREPORT.DTB file, saved in the software directory contains the last generated report.  
To archive the contents of this file use the SaveAs option to save the file under a new 
name. 

 
See Also:  Waveform Summary 

CHANGE DRIVE/DIRECTORY 

Location: File Manager  
 
Description: Change the file table's active path. 
 

Activation: Direct: F7, ChDir button , Back button , Up button , Right Mouse Click  
or Folder Tree  

Menu: Alt-F, H, Alt-F, T 
 
Comments: There is a number of ways to change the file table’s active path. Use the folder tree to 

navigate the connected drives.  To enter a path use the Change Drive/Directory dialog 
located in the File menu.  To select from a list of the last 12 active directories click the 
right mouse button.  To navigate back through the last 12 active directories use the Back 
menu button and to change to the previous directory use the Up menu button.  An error 
message is displayed if the destination path is not found.   

 
See Also:  Navigating Files in Chapter 1 

CHANGE FREQUENCY 

Location: Data Display 
 
Description: Change the current sampling frequency. 
 

Activation: Direct: Change Frequency menu button  
Menu: Alt-D, F 

 
Fields: Current Sampling Frequency:  The current sampling frequency. 
  Enter the New Sampling Frequency: The new sampling frequency. 
  Open Frequency:   Sets the driver to open with the new frequency. 
 
Options: Enter/Ok:    Change frequency. 

Esc/Cancel:    Exit the dialog without executing the command. 
 
Comments: The Open Frequency field will set the current display driver to always convert the files to 

the new frequency before displaying. 
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CHANGE QUERY OPERATORS 

Location: Query Fields 
 
Description: Change the operator for the active query field. 
 
Activation: Direct: F9 

Menu: Alt-Q, O 
 
Comments: To change the operator press F9 or click the left mouse button on the operator symbol. 
 
See Also:  Equal To (=),  

Greater Than (>),  
Less Than (<) 

CHANNEL BACKGROUND COLOR 

Location: Data Display 
 
Description: Change the background colors for the data display.  The background colors fields are in 

the “Window Properties” dialog under the “Colors” tab. 
 
Activation: Menu: Alt-F, T, Colors Tab 

CHANNEL INFORMATION (ON/OFF) 

Location: Data Display 
 
Description: Show or hide the channel information displayed in the frame to the right of the analog and 

digital traces. 
 

Activation: Direct: Analog table close button  
Menu: Alt-V, C 

 
Comments: The channel information frame can be resized by selecting the vertical separator bar and 

dragging it to the right or left.  The cursor changes to the vertical resize cursor when the 
mouse is positioned over the separator bar. 

CLEAR ANALOG COLORS 

Location: Data Display 
 
Description: Set the analog channel colors to the default color, black. 
 
Activation: Menu: Alt-C, C 
 
Comments: To change the color of an analog channel click the right mouse button on the channel ID 

or channel title. 

CLEAR QUERY AREA 

Location: Query Fields 
 
Description: Set all the query fields to blanks and default the query operators to equal (=). 
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Activation: Direct: F8 

Menu: Alt-Q, C 

COMBINE LOGS 

Location: File Manager 
 
Description: Combine a number of log files (ABB Load Profile, Comtrade Logs and SDC Logs), of 

different types (different columns), into one comma delimited file with the extension .CSV.   
 
Activation: Menu: Alt-O, R, L 
 
Comments: The files can be of different types (columns do not have to be equal).  The substation and 

device names for the data will be added as the first two columns in the file.  The result file 
can be displayed in a table. 

 
See Also: Append Logs 

COMBINED VIEW 

Location: Data Display 
 
Description: Display all the selected information contained in the analog table in a condensed form. 
 
Activation: Direct: F4 

Menu: Alt-V, A 
 
Comments: Use the F4 key to toggle between the tabular view and the combination view.  The 

combination view is only available if there is enough space between the analog channels 
to display three lines of text.  To change the positions of the data values select the 
“Window Properties” option from the “Option” menu, then click on the “Analog 
Combination” tab. 

 
See Also: Viewing Analog Information in Chapter 1. 

COMMA DELIMITED TABLE DRIVER  

Location: File Manager 
 
Description: Display the selected comma delimited file in a table format.  Comma delimited files have 

textual fields separated by commas, such as 0001,7834,872. 
 
Activation: Menu: Alt-D, T, C 
 
Comments: The file data is presented in tabular form.  An unlimited number of rows and columns can 

be displayed. 
 
See Also: Viewing ASCII Files in Database Format in Chapter 1. 

Double Quotes/Comma Delimited Table Driver 
Tab Delimited Table Driver 
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COMNAME PROPERTIES  

Location: File Manager 
 
Description: Setup the fields not available in the supported waveform files for the IEEE long file 

naming format. 
 
Activation: Menu: Alt-F, O 
 
Fields: Company Name: Enter the Company name that will be used in the long naming 

format. 
Time Code: Enter the time code for the device files to rename. 

  User Field 1:  Enter the 1st User Field. 
  User Field 2:  Enter the 2nd User Field. 
 
Options: Enter/Ok:  Save the entered data. 

Esc/Cancel:  Exit the dialog without saving. 
 
Comments: These fields are used for all the files renamed to the IEEE long file naming format.  

Update this dialog for files with different time code and user fields . 
 
See Also: ComName(s) Rename in Chapter 1 

ComName Properties in Chapter 1 
ComName(s) Rename 

COMNAME(S) RENAME  

Location: File Manager 
 
Description: Rename all the marked time sequenced data file to the IEEE long file naming format. 
 
Activation: Menu: Alt-F, A 
 
Comments: A message box will be prompted before renaming the file to insure the execution of the 

rename feature.  This feature will permanently rename the files.  It is advisable to back up 
the files before renaming.  Some proprietary applications may not be able to read the files 
once they are renamed. 

 
See Also: ComName(s) Rename in Chapter 1. 

ComName Properties 

COMPANY COLUMN  

Location: File Manager 
 
Description: Displays the company name associated with the long file name.  The sixth field in the file 

name defines the company field for the IEEE long file-naming format. 
 
See Also: Long File Naming Format in Chapter 1. 

COMPRESS COMTRADE FILES  

Location: File Manager 
 
Description: Convert all the marked COMTRADE ASCII files to COMTRADE Binary files. 
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Activation: Menu: Alt-O, C 
 
Comments: This feature compresses the COMTRADE ASCII file size.  It is useful for porting files to 

floppy or transferring files through a medium. 
 
See Also: Compressing COMTRADE Files in Chapter 1. 

COMTRADE DRIVER 

Location: File Manager 
 
Description: Change the driver at the cursor position to the COMTRADE driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, 5 
 
Comments: All files that have a “.DAT” or ‘’D##” file extension, and a corresponding “.CFG” file are 

tagged as COMTRADE files.  If the selected file does not have a corresponding “.CFG” 
file an error message is generated.  Both the COMTRADE ASCII and Binary formats are 
supported. 

CONDENSE TIME 

Location: Data Display 
 
Description: Condense the time scale for all visible channels.  
 

Activation: Direct: Ctrl-Page Down or the Condense menu button  
Menu: Alt-D, C  

 
See Also: Expand Time 

COPY/CUT/PASTE FILES 

Location: File Manager 
 
Description: Copy or Cut the marked files to the clipboard.  Navigate to the destination folder and 

Paste the files. 
 

Activation: Direct: Ctrl-X (Cut) , Ctrl-C (Copy) , Ctrl-V (Paste)  
Menu: Alt-E, T (Cut), Alt-E, C (Copy), Alt-E, P (Paste) 

 
Comments: Marked files are displayed in red.  The TotMarks and MrkSize fields displayed in the 

status bar are updated accordingly.  To copy/cut/paste files use the Edit menu options, 
the shortcut keys or right click in the file table and select the desired option.  

 
See Also:  Copy File 

Move Files 
Mark/Unmark File 
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COPY FILES 

Location: File Manager 
 
Description: Copy the marked files to the specified destination path.  If the path does not exist, type 

the directory name in the edit box.  The system prompts prior to creating the directory. 
 

Activation: Direct: F8 or the Copy menu button  
Menu: Alt-F, C 

 
Fields: Directory Name: The destination path where the marked files are to be copied.  

To specify a new path type the path directly into this edit box. 
Directories: Displays a tree of the system’s directories, double click to open a 

node in the tree and click on the desired directory to highlight it. 
  Files:   Displays a list of the files in the highlighted directory. 
  Drives:   A list of all the connected drives.  Select the desired drive. 
 
Options: Enter/Ok:  Copy the marked files to the destination path. 

Esc/Cancel:  Exit the dialog without executing the command. 
 
Comments: Marked files are displayed in red.  The TotMarks and MrkSize fields displayed in the 

status bar are updated accordingly.  Files that where unsuccessfully copied are marked 
and grouped at the top of the table. 

 
See Also:  Move Files 

Mark/Unmark File 

COPY TEXT 

Location: ASCII Editor 
 
Description: Copy the blocked text to the clipboard. 
 

Activation: Direct: Ctrl-C, Ctrl-Ins - Copy menu button  
Menu: Alt-E, C 

 
Comments: To block text use the shift key plus the up arrow, down arrow, page up and page down 

keys or the drag the mouse. 
 
See Also:  Cut Text 

Paste Text 

CREATE DIRECTORY 

Location: File Manager 
 
Description: Create a new directory. 
 
Activation: Menu: Alt-F, E 
 
Fields: Directory: The new directory's name. 
 
Options: Enter/Ok: Create the new directory. 

Esc/Cancel: Exit the dialog without executing the command. 
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Comments: If there is no path defined the new directory is placed in the active directory. 

CUT TEXT 

Location: ASCII Editor 
 
Description: Copy the blocked text to the Windows clipboard then delete the blocked text. 
 

Activation: Direct: Ctrl-X, Shift-Del - Cut menu button  
Menu: Alt-E, T 

 
Comments: Use the shift keys and the up arrow, down arrow, page up and page down keys to block 

text. 
 
See Also:  Copy Text 

Paste Text 

CYCLE HOP 

Location: Data Display 
 
Description: Move the data bar (vertical black solid line) one cycle forward or backward in time. 
 
Activation: Direct: Shift-Ctrl-Left arrow and Shift-Ctrl-Right arrow 
 
Comments: Use the shift+ctrl left/right keys to move one cycle in time.  The number of cycles is 

displayed in the status bar with the Reference bar (vertical blue dotted line) as the 
reference position. 

 
See Also:  Peak Hop 

Data Bar 

D&T 

Location: Data Display (Status Field)  
 
Description: Displays the data and time of the sample at the data bar. 
 
See Also:  Delta X Field 

DATA BAR 

Location: Data Display 
 
Description: Displays the channel’s instantaneous sample value.  The data bar is the solid black line 

that runs vertically across the analog and digital channels.   
 
Comments: The data bar is used to view channel information (such as analog sample values, RMS 

values, digital information, data and time…).  The information is displayed in the channel 
frame positioned to the right of the traces and in the status bar.  The Ctrl-Left/Right keys 
moves the data peak to peak and the Shift-Ctrl-Left/Right keys moves the data one cycle 
in time. 
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See Also:  RMS bar 

Reference bar 
Horizontal Bars 
Cycle Hop 
Peak Hop 

DECREASE AMPLITUDE 

Location: Data Display 
 
Description: Decrease the amplitude of all or marked analog channels. 
 

Activation: Direct: Ctrl-Down Arrow or the AmpDn menu button  
Menu: Alt-D, D 

 
Comments: When the channels’ amplitude is decreased the Trace Scale Multiplier is divided into the 

Pixsdisp value.  To change the Trace Scale Multiplier, select “Window Properties” from 
the “File” menu then select the “Display Settings” tab. 

 
See Also: Increase Amplitude 

Trace Scale Multiplier  

DELETE FILES 

Location: File Manager 
 
Description: Remove all the marked files and empty directories from the active directory. 
 
Activation: Direct: Delete 

Menu: Alt-F, D 
 
Comments: Marked files and directories are displayed in red.  The TotMarks and MrkSize fields 

displayed in the status bar are updated accordingly.  Files and directories that were 
unsuccessfully deleted are marked and grouped at the top of the table. 

 
Restrictions: A marked directory must be empty in order to remove it from the file table. 
 
See Also: Mark/Unmark File 

DELETE TEXT 

Location: ASCII Editor 
 
Description: Delete the blocked text from the document. 
 
Activation: Direct: Del 

Menu: Alt-E, D 
 
Comments: Use the shift keys and the up arrow, down arrow, page up and page down keys to block 

text. 
 
See Also:  Cut Text 
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DELTA X 

Location: Data Display (Status Field)  
 
Description: Displays the time in microseconds, milliseconds, or seconds between the RMS bar and 

the data bar.  The number of cycles is also displayed if the samples in the file are 
microseconds or milliseconds apart. 

 
See Also:  D&T Field 

RMS bar 

DELTA Y 

Location: Data Display (Status Field)  
 
Description: Displays the difference between the data horizontal bar and the reference horizontal bar. 
 
See Also:  Delta X Field 

DESCENDING SORT 

Location: All Tables 
 
Description: Sort the file columns in descending order with respect to the selected sort field.   
 
Activation: Menu: Alt-S, D 
 
Comments: To change the sort field, place the cursor in the desired column and select “Set Sort 

Field” in the Sort menu.  The sort field is displayed in the status bar at the bottom of the 
window.  To sort the table columns directly press the column header button.  The header 
buttons toggle between ascending and descending order. 

 
See Also: Ascending Sort  

Sorting Files in Chapter 1 

DEVICE COLUMN  

Location: File Manager 
 
Description: Displays the device name associated with the long file name.  The fifth field in the file 

name defines the device field for the IEEE long file-naming format.  It represents the 
name or code of the device that originated the file.   

 
See Also: Long File Naming Format in Chapter 1. 

DIGITAL MARK/UNMARK ALL 

Location: Data Display 
 
Description: Marked all digital channels if there are no digital channels marked else unmark all the 

marked digital channels. 
 
Activation: Menu: Alt-C, I 
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Comments: The channels ID and titles are displayed in light red when marked.  Press F8 to mark or 
unmark all the analog and digital channels. 

DISPLAY DIALOG 

Location: File Manager 
 
Description: Reposition the columns in the file table. 
 
Activation: Menu: Alt-O, D 
 
Fields: File Column List: A list of all the columns in the file table. 
 
Options: Move Up:  Move the highlighted column before the previous column. 

Move Down:  Move the highlighted column after the next column. 
Reset: Default the order of the columns to how they were when the 

software was first installed. 
OK:   Change the order of the columns and redraw the file table. 
Cancel:   Exit the dialog without executing the command. 

 
Comments: To resize the table columns place the mouse over the column separator and drag the 

mouse to the left or the right or double click on the column separator to expand to the 
maximum area for that column. 

 
See Also:  Customizing the Table Display in Chapter 1 

Resize Columns 

DOUBLE QUOTES/COMMA DELIMITED TABLE DRIVER  

Location: File Manager 
 
Description: Display the double quote delimited file in a table format.  Double quote-delimited files 

have textual fields separated by double quotes and commas, such as 
“CHANNEL”,”DATE”,”TIME”. 

 
Activation: Menu: Alt-D, T, Q 
 
Comments: The file data is presented in tabular form.  An unlimited number of rows and columns can 

be displayed. 
 
See Also: Viewing ASCII Files in Database Format in Chapter 1. 

Comma Delimited Table Driver 
Tab Delimited Table Driver 

DRIVER COLUMN  

Location: File Manager 
 
Description: Displays the display driver associated with the file. 
 
See Also: Associating File Types in Chapter 1. 
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DRIVER DATA TYPE 

Location: Data Display 
 
Description: Set the active display driver’s data type. 
 

Activation: Direct: Window Properties menu button  
  Menu: Alt-F, T 
 
Comments: The data stored in the displayed file can be instantaneous values or RMS values. The 

default setting for all drivers is instantaneous values.  If the display device saves the 
sample values as RMS calibrated then select RMS Calibrated Type from the drop down 
list.  If the data type is RMS Calibrated and the data type is not set to RMS calibrated 
type then the analog column data will be displayed incorrectly. 

DUPLICATE CYCLES 

Location: Data Display 
 
Description: Duplicate the cycle between the Data bar and the RMS bar. 
 

Activation: Direct: Duplicate Cycles menu button  
  Menu: Alt-D, L 
 
Fields: # Cycles: Enter the number of time to duplicate the highlighted cycle(s). 
 
Options: Enter/Ok: Duplicate the highlighted cycle(s) . 

Esc/Cancel: Exit the dialog without executing the command. 
 
Comments: This feature is useful for creating test set files or for creating file to play back into 

simulation or modeling applications. 
 
See Also:  Duplicating cycles in Chapter 1 

Truncate Cycles 

DXF DRIVER 

Location: File Manager 
 
Description: Displays the file(s) drawing information in graphical form. 
 
Activation: Menu: Alt-D, D, S or M 
 
Comments: An error message is displayed if the file is not a valid DXF file.  All files that have the 

“.DXF” extension are tagged as DXF files.  A single file can be opened or multiple files 
can be opened at the same time.  For multiple files first mark the files then select Marked 
files from the DXF submenu option. 

EMAIL FILES 

Location: File Manager & Data Display 
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Description: Email a group of files or a single file using the users default email application.  All support 
files needed to display the selected files will be automatically attached.  Support files 
include the Comtrade configuration (*.CFG), header (*.HDR) & information (*.INF) files. 

 
Activation: Menu: File Manager: Alt-F, L  Data Display: Alt-F, E 
 
Fields: To:   Recipient of the email, initially empty. 

From: Sender, automatically defaulted. 
Subject: Empty. 
Attachment: All selected files and their support files automatically attached. 

 
Comments: Files can be email either in the file table or in the data display. To email a set of files, 

mark the desired files in the file table and select the “Email Marked Files” option from the 

“File” menu or right click on the file table and select the “Email”  option from the 
pop-up menu.  To email a file from the data display window select the “Email Active File” 
option under the “File” menu.  All support files needed to display the file(s) are 
automatically attached. 

 
See Also: Email Files and Email Active File in Chapter 1. 

EQUAL TO (=) 

Location: Query Fields 
 
Description: Search the active directory for files that match the entered criteria. 
 
Comments: To change the query operator press F9 or click the left mouse button on the operator 

symbol. 
 
See Also:  Greater Than (>) 

Less Than  (<) 

EXPAND TIME 

Location: Data Display 
 
Description: Expand the time scale of all visible analog channels. 
 

Activation: Direct: Ctrl-Page Up or the Expand menu button  
Menu: Alt-D, E 

 
See Also: Condense Time 

F-TYPE COLUMN  

Location: File Manager 
 
Description: Displays the file type.  The “/dr” indicates that the file is a sub-directory.  The DAU ID 

number is displayed for DFR I, II, IIB and 2000 files and the extension of the file is 
displayed for all other files. 
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Comments: If the active directory is a sub-directory then the first 2 rows of the table are reserved for 
the “.” and “..” navigation shortcuts.  The “.” is a shortcut to the root directory and the “..” 
is a shortcut to the previous directory.   

FAULT DATE COLUMN  

Location: File Manager 
 
Description: Displays the fault date of the oscillography files.  This column is left blank if the file is not 

a valid oscillography file or the fault date and time is not available in the file name.   
 
See Also: Fault Time Column 

FAULT REFERENCE TIME BAR 

Location: Data Display 
 
Description: Displays the time difference from the fault time defined in the displayed file.  The units are 

displayed in the Delta X status field. 
 
Comments: The fault reference time bar is displayed between the analog channels and the digital 

channels.  To show or hide the fault reference time bar open the “Window Properties” 
dialog under the “File” menu.  Click the “Display Settings” tab and toggle the “Show 
Reference Time Bar” field. 

 
See Also: Fault Reference Time Bar in Chapter 1 

FAULT TIME COLUMN  

Location: File Manager 
 
Description: Displays the fault time of the oscillography files.  This column is left blank if the file is not 

a valid oscillography file or the fault date and time is not available in the file name.   
 
See Also: Fault Date Column 

FILE NAME COLUMN  

Location: File Manager 
 
Description: Displays the name of the files/directories in the active directory. 
 
Comments: If the active directory is a sub-directory then the first 2 rows of the table are reserved for 

the “.” and “..” navigation shortcuts.  The “.” is a shortcut to the root directory and the “..” 
is a shortcut to the previous directory. 

 
See Also: F-Type Column 

FLIP MARKS 

Location: All Tables 
 
Description: Mark all the unmarked rows and unmark all the marked rows. 
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Activation: Menu: Alt-M, F  
 
Comments: Marked rows are displayed in red. The TotMarks field displayed in the status bar is 

updated accordingly. 
 
See Also: Unmark Marked Rows 

Mark/Unmark Row 

FOLDER TREE 

Location: File Manager 
 
Description: Displays all connected drives and folders in a tree structure. 
 
Activation: Menu: Alt-F, T – Toggle Show/Hide Tree  
 
Comments: To show/hide the folder tree select the “Show/Hide Folder Tree” option under the “File” 

menu.  Folders can be renamed by left mouse clicking on the folder name until the editor 
is displayed. Also, folders that reside on the computer can be sent to the recycle bin by 
selecting the “Delete” option under the folder tree’s right click pop-up menu. If the folders 
reside on external drives then they are permanently deleted. 

 
See Also: Navigating in Chapter 1 

Change Drive/Directory 

FREE   

Location: File Manager (Status Field)  
 
Description: Displays the amount of free hard disk space on the active drive, displayed in Kbytes. 
 
See Also:  Size 

MrkSize 

FS 

Location: Data Display (Status Field)  
 
Description: Displays the sampling frequency of the sample at the data bar. 

FST 

Location: Waveform Summary (Events/Sensors Activity Summary)  
 
Description: Displays the status of the first digital samples in the file.  Fst is the first column in the 

Events/Sensors Activity Summary.  A=Alarm, N=Normal. 
 
Comments: This data is also displayed in the second column of the digital information table view. 

FST-CHANGE   

Location: Waveform Summary (Events/Sensors Activity Summary)  
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Description: Displays the date and time the channel first changed state.  Fst-Change is the third 

column in the Events/Sensors Activity Summary. 
 
Comments: This data is also displayed in the forth column of the digital information table view. 

GROUP MARKED ANALOG CHANNELS 

Location: Data Display 
 
Description: Group all the marked analog channels and move them to the top of the display area. 
 
Activation: Menu: Alt-C, G 
 
See Also: Mark/Unmark Channels 

GROUP MARKED ROWS 

Location: All Tables 
 
Description: Group all the marked rows and move them to the top of the table. 
 
Activation: Menu: Alt-M, G 
 
See Also: Unmarked Marked Rows 

Toggle Marked Rows 
Mark/Unmark Row 

HARMONICS TABLE 

Location: Data Display 
 
Description: View the harmonics table. 
 
Activation: Direct: F11, Right click on phasor diagram or information header 

Menu: Alt-V, T 
 
Comments: The harmonics table displays the number of harmonics according to the file’s sampling 

frequency with a maximum of 200 harmonics supported. The table displays one channel 
at a time.  It will display the 1

st
 marked analog channel, or if no channels are marked then 

the first visible channel.  The harmonic calculation is performed on one cycle of data, 
starting at the RMS bar to the data bar.  The display values include DFT Peak, DFT 
RMS, DFT Angles, % of fundamental and % of TrueRMS.  When the data bar is moved in 
the data plotting window the harmonics values will be automatically updated.  To view the 

harmonics in a histogram click on the harmonics toggle  button located next to the 
channel name. 

 
See Also: Harmonics in Chapter 1 

Histogram 
Harmonics Vectors 
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HARMONIC VECTORS 

Location: Data Display 
 
Description: View the harmonics vectors in the phasor diagram. 
 
Activation: Menu: Alt-V, H 
 
Comments: The harmonics of the first marked analog channel, or if no channels are marked then the 

first visible analog channel, is displayed in a vector format in the phasor diagram.  The 
harmonic calculation is performed on one cycle of data.  It starts at the RMS bar and 
goes forward one cycle.  To hide/show the harmonic vectors toggle the "Vector 
Harmonics" menu option under the "View" menu from checked=ON to unchecked=OFF. 

 
See Also: Harmonics in Chapter 1 

Histogram 
Harmonics Table 

 

HELP 

Location: All Child Windows.  
 
Description: Displays the help file for the active child window. 
 
Activation: Direct: F1 

Menu: Alt-H, T 
 
Comments: The information contained in the help window is organized in the following fashion:  

Specific Features for the active window, 
Function Keys, 
Menu Options, 
Button Menu Bar, 
Cursor Keys, 
Mouse Actions and 
Status Bar 

HEXADECIMAL EDITOR 

Location: File Manager 
 
Description: Edit the file at the cursor position in a binary editor. 
 
Activation: Direct: F3 

Menu: Alt-O, X 
 
Comments: The file contents are displayed in a Hex editor.  Use the up arrow, down arrow, page up, 

page down, Ctrl-home and Ctrl-end keys to navigate through the file’s data, or use the 
scroll bar.  When a hex value is over written the ASCII equivalent is displayed in the 
window to the right of the editor.  A maximum of 10 viewing windows can be 
simultaneously.  The F4 and F3 function keys allow for searching ASCII data or Hex 
values.  To search for hex values insert the “#” character before the hex value in the 
“Find Text” field. 
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HEXADECIMAL DRIVER 

Location: File Manager 
 
Description: Change the driver at the cursor position to the Hexadecimal driver and display the file in 

binary format. 
 
Activation: Menu: Alt-D, X 
 
See Also: Hexadecimal Editor 

HIDE MARK(S)  

Location: Data Display 
 
Description: Hide all the marked analog channels and re-space the unmarked channels.  
 
Activation: Direct: Delete 

Menu: Alt-C, H 
 
Comments: To mark/unmark an analog channel, click the channel ID or the channel data. 
 
See Also: View Mark(s) 

Show All Hidden 
Restore Mark(s) 

HISTOGRAM 

Location: Data Display 
 
Description: View the harmonics histogram. 
 
Activation: Direct: F11, Right click on phasor diagram or information header 

Menu: Alt-V, T 
 
Comments: The histogram displays the number of harmonics according to the file’s sampling 

frequency with a maximum of 200 harmonics supported. The histogram displays one 
channel at a time.  It will display the 1

st
 marked analog channel, or if no channels are 

marked then the first visible channel.  The harmonic calculation is performed on one 
cycle of data, starting at the RMS bar to the data bar.  The display values can be DFT 
Peak, DFT RMS, DFT Angles, % of fundamental and % of TrueRMS. The default view is 
% of fundamental. To change the data displayed click on the drop down menu button 

and select from the list. When the data bar is moved in the data plotting window 
the harmonics values will be automatically updated.  To view the harmonics in a table 

click on the harmonics toggle  button located next to the channel name. 
 
See Also: Harmonics in Chapter 1 

Harmonics Table 
Harmonics Vectors 

HORIZONTAL BARS 

Location: Data Display 
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Description: Displays a solid black line that follows the data bar and displays a dotted blue line that 

follows the reference bar.   
 
Activation: Menu: Alt-V, B 
 
Comments: The bars will be positioned at the first marked analog channel (displayed in red).  If no 

channels are marked then they are positioned at the first displayed channel.  The Delta Y 
field in the status bar shows the difference between the two bars. 

 
See Also:  RMS bar 
  Data Bar 
  Reference Bar 

HP-DIF   

Location: Waveform Summary 
 
Description: Displays the absolute value of the HPeak-Up minus the absolute value of the HPeak-Dn 

divided by the OneBit value. 
 
Comments: The Hpeak-Up value is the highest positive peak in the channel.  The Hpeak-Dn is the 

highest negative peak in the channel.  The OneBit value is the channel's full-scale value 
divided by the channel's resolution. 

 
See Also: Viewing Waveform Summaries in Chapter 1 

HPEAK-DN   

Location: Waveform Summary 
 
Description: The highest negative peak value in the channel. 
 
See Also: Viewing Waveform Summaries in Chapter 1 

HPEAK-UP   

Location: Waveform Summary 
 
Description: The highest positive peak value in the channel. 
 
See Also: Viewing Waveform Summaries in Chapter 1 

INCREASE AMPLITUDE 

Location: Data Display 
 
Description: Increase the amplitude of all or marked analog channels. 
 

Activation: Direct: Ctrl-Up arrow or the AmpUp menu button  
Menu: Alt-D, I 
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Comments: When the channels’ amplitude is increased the Trace Scale multiplier is multiplied into 
the Pixsdisp value.  To change the Trace Scale Multiplier select “Window Properties” 
from the “File” menu then select the “Display Settings” tab.  

 
See Also: Decrease Amplitude 

Auto Scale Multiplier 

INSTPEAK COLUMN 

Location: Data Display (Analog Table)  
 
Description: Displays the peak value measured between the two reference crossings surrounding the 

data bar (black solid line).  The value is displayed as Peak type.  If the data type for the 
loaded driver is set to RMS calibrated then the value is multiplied by the square root of 2. 

 
Comments: The value is displayed as Peak type.  If the data type for the loaded driver is set to RMS 

calibrated then the value is multiplied by the square root of 2. 
 
See Also: Viewing Analog Data in Chapter 1 

INSTVAL COLUMN 

Location: Data Display (Analog Table)  
 
Description: Displays the instantaneous sample value at the data bar. 
 
Comments: This value is multiplied by the square root of 2 if the driver’s data type is set to RMS 

calibrated. 
 
See Also: Viewing Analog Data in Chapter 1 

Data Bar 

LESS THAN (<) 

Location: Query Fields 
 
Description: Search the active directory for files that are less than the entered criteria. 
 
Comments: To change the operator press F9 or click the left mouse button on the operator symbol. 
 
See Also:  Equal To (=) 

Greater Than (>) 

LP-DIF 

Location: Waveform Summary 
 
Description: Displays the absolute value of the LPeak-Up minus the absolute value of the LPeak-Dn 

divided by the OneBit value. 
 
Comments: The Lpeak-Up value is the lowest positive peak in the channel.  The Lpeak-Dn is the 

lowest negative peak in the channel.  The OneBit value is the channel's full-scale value 
divide by the channel's resolution. 
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See Also: Viewing Waveform Summaries in Chapter 1 

LPEAK-DN   

Location: Waveform Summary 
 
Description: The lowest negative peak value in the channel. 
 
See Also: Viewing Waveform Summaries in Chapter 1 

LPEAK-UP   

Location: Waveform Summary 
 
Description: The lowest positive peak value in the channel. 
 
See Also: Viewing Waveform Summaries in Chapter 1 

LST   

Location: Waveform Summary (Events/Sensors Activity Summary)  
 
Description: Displays the status of the last digital samples in the file.  Lst is the second column in the 

Events/Sensors Activity Summary.  A=Alarm, N=Normal. 
 
Comments: This data is also displayed in the third column of the digital information table view. 

LST-CHANGE 

Location: Waveform Summary (Events/Sensors Activity Summary)  
 
Description: Displays the date and time the digital channel last changed state.  Lst-Change is the forth 

column in the Events/Sensors Activity Summary.   
 
Comments: This data is also displayed in the fifth column of the digital information table view. 

MARK ALL ROWS 

Location: All Tables 
 
Description: Mark all the rows in the table. 
 

Activation: Direct: Mark menu button (if no files are marked).  
Menu: Alt-M, A 

 
Comments: Marked rows are displayed in red.  The TotMarks field displayed in the status bar is 

updated accordingly.  The Mark menu button toggles between marking and unmarking all 
rows in the table. 

 
See Also: Unmarked Marked Rows 

Flip Marks 
Group Marked Rows 
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MARK/UNMARK ALL CHANNELS 

Location: Data Display 
 
Description: Unmark all analog & digital channels if the total number of marked channels is less than 

the total number of displayed channels otherwise mark all the channels. 
  
Activation: Direct: F8 

Menu: Alt-C, M 
 
Comments: When an analog channel is marked the ID, title, ASV, and units are displayed in light red.  

When a digital channel is marked the ID and titles are displayed in light red.  To mark or 
unmark a channel click the channel’s corresponding ID number or title, or use the space 
bar. 

MARK/UNMARK ROW 

Location: All Tables 
 
Description: Toggle the row at the cursor position between the marked and unmarked state. 
 
Activation: Direct: Spacebar, Ctrl-Left Mouse Click 

Menu: Alt-M, M 
 
Comments: Marked rows are displayed in red.  The TotMarks field displayed in the status bar is 

updated accordingly.  The Mark menu button toggles all the rows in the table between the 
marked and unmarked state. 

MARK CHANGE IN SIGN 

Location: Data Display 
 
Description: Mark all positions in the analog channels where the waveform changes in sign. 
  
Activation: Menu: Alt-A, H 
 
Comments: A small gray triangle marks the change in sign position. 
 
See Also: Mark Raw Values 

Mark Peak Values 

MARK PEAK VALUES 

Location: Data Display 
 
Description: Mark all positive and negative peaks on the analog channels. 
  
Activation: Menu: Alt-A, H 
 
Comments: A small gray square marks the positive and negative peaks. 
 
See Also: Mark Change in Sign 

Mark Raw Values 
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MARK RAW VALUES 

Location: Data Display 
 
Description: Mark all the raw samples read from the active waveform file. 
  
Activation: Menu: Alt-A, M 
 
Comments: A small clear circle marks the raw samples read from the file. 
 
See Also: Mark Change in Sign 

Mark Peak Values 

MAX X PIXELS  

Location: DXF Display (Drawing Constants Dialog)  
 
Description: Displays the total number of X pixels allocation for the current DXF drawing. 
 
Activation: Direct: F2 

Menu: Alt-F, D 
 
Comments: This value changes when the Zoom In and Zoom Out features are used and is updated 

accordingly in the DXF status bar. 
 
See Also: Zoom In 

Zoom Out 
Zoom X, Y Resolution Constants 

MAX Y PIXELS  

Location: DXF Display (Drawing Constants Dialog)  
 
Description: Displays the total number of Y pixels allocation for the current DXF drawing. 
 
Activation: Direct: F2 

Menu: Alt-F, D 
 
Comments: This value changes when the Zoom In and Zoom Out features are used and is updated 

accordingly in the status bar. 
 
See Also: Zoom In 

Zoom Out 
Zoom X, Y Resolution Constants 

MAXPEAK COLUMN 

Location: Data Display (Analog Table)  
 
Description: Displays the maximum peak value of the channel. 
 
Comments: If the active driver’s data type is set to RMS calibrated then the files maxpeak value is 

multiplied by Root 2. 
 
See Also: Viewing Analog Data in Chapter 1 
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MAXVAL COLUMN 

Location: Data Display (Analog Table)  
 
Description: Displays the maximum value of the channel. 
 
Comments: This column is displayed if the active driver’s data type is set to Non-Sinusoidal-Log Files. 
 
See Also: Viewing Analog Data in Chapter 1 

MAXWIN COLUMN 

Location: Data Display (Analog Table)  
 
Description: Displays the absolute maximum value between the RMS bar (black dotted line) and the 

data bar (black solid line). 
 
Comments: This column is displayed if the active driver’s data type is set to Non-Sinusoidal-Log Files. 
 
See Also: Viewing Analog Data in Chapter 1 

Data Bar 
RMS Bar 

MEDIUM DISPLAY 

Location: Data Display 
 
Description: Display the analog channel using the maximum pixels allowed with no zero reference 

point.  The medium display is activated through the Auto Scale feature. 

Activation: Direct: F6, - Auto Scale button  
Menu: Alt-D, A, P 

 
Comments: The Auto Scale toggles between (Off, On and ++).  ++ plots the signal using the number 

of maximum pixels allowed for the channel.  The highest value is plotted at the maximum 
position allowed and the smallest value is plotted at the lowest position allowed.  This 
feature was added to clearly show the profile of frequency, Vdc and load data channels. 

 
See Also: Scaling Analog Channels in Chapter 1 
 AS Status Field 
 Auto Scaling 

MERGE OPEN FILES 

Location: Data Display 
 
Description: Merge the visible or marked channels from all the open data display windows into a new 

data display window.  There are three Merge options available.  Merge files “By Time” will 
merge only the common times in the open files.  Merge files “Manually” will merge the 
data according to the positions of the data bars in each open window.  Merge files “By 
Sample” will merge the files by lining up the samples in each open window. 

 
Activation: Menu: Alt-F, G, B-“By Time”, M-“Manually”, S-“By Sample” 
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Comments: To distinguish between the merged channels the station name is placed before each 
channel merged.  To deactivate this feature open the “Window Properties” dialog, select 
the “Append/Merge” tab and click the “Merge Files” option.  If the files have different 
sampling frequencies a dialog will be display to select the frequency for the new window. 

 
See Also: Merge Open Files in Chapter 1 
 Merge Waveform Files 

MERGE WAVEFORM FILES 

Location: File Manager 
 
Description: Merge all the channels from the marked waveform file into a data display window.  There 

are two Merge options available.  Merge files “By Time” will merge only the common 
times in the open files.  Merge files “By Sample” will merge the files by lining up the 
samples in each open window. 

 
Activation: Menu: Alt-O, W, M, B-“By Time”, S-“By Sample” 
 
Comments: To distinguish between the merged channels the station name is placed before each 

channel merged.  To deactivate this feature open the data display “Window Properties” 
dialog, select the “Append/Merge” tab and click the “Merge Files” option.  If the files have 
different sampling frequencies a dialog will be display to select the frequency for the new 
window. 

 
See Also: Merge Waveform Files in Chapter 1 
 Merge Open Files 

MINPEAK COLUMN 

Location: Data Display (Analog Table)  
 
Description: MinPeak is the column that displays the minimum peak value of the channel. 
 
Comments: If the active driver’s data type is set to RMS calibrated then the files minpeak value is 

multiplied by Root 2. 
 
See Also: Viewing Analog Data in Chapter 1 

MINVAL COLUMN 

Location: Data Display (Analog Table)  
 
Description: Displays the minimum value of the channel. 
 
Comments: This column is displayed if the active driver’s data type is set to Non-Sinusoidal-Log Files. 
 
See Also: Viewing Analog Data in Chapter 1 

MOVE FILES 

Location: File Manager 
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Description: Copy the marked files to the specified destination path then delete the files from the 
source directory.  If a file is not copied successfully it is marked and grouped at the top of 
source directory.  To create a new destination directory enter the name into the 
Directories edit box.  The system prompts prior to creating the new directory. 

 

Activation: Direct: F9, - Move menu button  
Menu: Alt-F, M 

 
Fields: Directory Name: The destination path where the marked files are to be moved.  

To specify a new path, type the path directly into this edit box. 
Directories: Displays a tree of the system’s directories, double click to open a 

node in the tree and click on the desired directory to highlight it. 
  Files:   Displays a list of the files in the highlighted directory. 
  Drives:   A list of all the connected drives.  Select the desired drive. 
 
Options: Enter/Ok:  Move the marked files to the selected destination path. 

Esc/Cancel:  Exit the dialog without executing the command. 
 
Comments: Marked files are displayed in red.  The TotMarks and MrkSize fields displayed in the 

status bar are updated accordingly.   
 
See Also:  Copy Files 

Mark/Unmark File 

MOVE RMS BAR TO REFERENCE BAR 

Location: Data Display 
 
Description: Move the RMS bar (black dotted line) to the sample at the Reference bar position (blue 

dotted line). 
 

Activation: Direct: Ctrl-Z – Set RMS bar menu button  
Menu: Alt-V, R 

 
Comments: The RMS and Data bars define the RMS sliding window. 
 
See Also: Setting the Cursor Bars in Chapter 1 

RMS Bar 

MOVE REFERENCE BAR TO DATA BAR 

Location: Data Display 
 
Description: Move the Reference bar (blue dotted line) to the sample at the Data bar position (black 

solid line). 
 

Activation: Direct: Ctrl-A – Set Reference Bar menu button  
Menu: Alt-V, M 

 
Comments: The Delta time field (Delta X) in the status bar at the bottom of the screen displays the 

time difference between the reference bar and the data bar.  If the time difference 
between the samples is in milliseconds or microseconds then the number of cycles 
between the two bars is also displayed.   
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See Also: Setting the Cursor Bars in Chapter 1 
Data Bar 
Reference Bar 

MRKSIZE   

Location: File Manager (Status Field)  
 
Description: Displays the combined size  (in Kbytes) for all marked files. 
 
See Also:  Size 

Free 

NEW FILE 

Location: ASCII Editor 
 
Description: Open a new empty ASCII edit window with the title defaulted to Untitled. 
 
See Also: Open File 

ONEBIT   

Location: Waveform Summary 
 
Description: Displays the analog channel's full-scale value divide by the channel's resolution. 
 
Comments: The OneBit value is used to calculate the HP-Dif and the LP-Dif. 
 
See Also: Viewing Waveform Summaries in Chapter 1 

HP-Dif 
LP-Dif 

OPEN ALL MARKED WAVEFORM FILES 

Location: File Manager 
 
Description: Open all the marked waveform files in the file table and minimize the file table. 
 
Activation: Menu: Alt-O, W, F 
 
Comments: All the marked waveform files are opened, tiled and the file table is minimized.  A 

maximum of 10 data windows can be open at one time. 
 
See Also: Open All Marked Files in Chapter 1 

OPEN FILE   

Location: ASCII Editor 
 
Description: Open the window open file dialog box to select an existing file.  The open file will be put 

in a new ASCII edit window. 
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See Also: New File 

OPTIONAL COLUMNS  

Location: File Manager 
 
Description: The IEEE PSRC long file naming convention allows for user defined fields appended at 

the end of the filename.  The file table reserves 4 columns for the first 4 user defined 
fields.  The columns are named Optional-1 to Optional-4. 

 
See Also: Long File Naming Format in Chapter 1. 

PATH/FILENAME (NO EXT.)  

Location: Save as COMTRADE Dialog (ASCII/Binary)  
 
Description: Displays the destination path and filename of the new COMTRADE file. 
 
Comments: The oscillography file at the cursor position is saved in COMTRADE format to the 

specified filename.  When specifying a filename do not enter an extension, the “.CFG” 
and “.DAT” files are automatically created.  If a path is not specified the files are saved to 
the active directory. 

 
Restrictions: The filename cannot contain an extension. 

PASTE TEXT 

Location: ASCII Editor 
 
Description: Paste the contents of the clipboard into the document at the cursor position.  Existing 

blocked text is overwritten with the contents of the clipboard. 
 

Activation: Direct: Ctrl-V, Shift-Ins - Paste menu button  
Menu: Alt-E, P 

 
Comments: Use the shift keys and the up, down, page up and page down keys to block file text. 
 
See Also:  Copy Text 

Cut Text 

PHASOR/CIRCULAR CHART SCALE MULTIPLIER (ASM) 

Location: Data Display (Window Properties Dialog)  
 
Description: Used as a multiplier to increase/decrease the length of a vector in the phasor diagram or 

to increase/decrease the circular chart data. 
 
Activation: Menu: Alt-F, T, “Display Settings” Tab 
 
Range: Greater Than 1.00 
 
Default: 2.00 
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Comments: When a channel's amplitude is increased, the phasor/circular chart scale value is 
multiplied with the Pixsdisp value, and when the channel's amplitude is decreased the 
phasor/circular chart scale value is divided by the Pixsdisp value . 

PIXSDISP COLUMN 

Location: Data Display 
 
Description: Displays the number of pixels allocated for the channels.   

 
Comments: When a channels’ amplitude is increased or decreased the trace scale multiplier, set in 

the “Window Properties” dialog, is multiplied or divided with the PixsDisp values in the 
analog information table.  To increase or decrease the channels’ amplitude, select 
“Increase Amplitude” or “Decrease Amplitude” from the Data menu.  If no channels are 
marked, all channels are scaled accordingly. 

 
See Also: Trace Scale Multiplier  

Auto Scaling 

PLAY CHANNELS AUDIO 

Location: Data Display 
 
Description: Plays the audio of the first marked analog channel. If no channels are marked then it 

plays the audio of the first displayed channel. 
 
Activation: Menu: Alt-D, P 
 
Fields: Analog Channel: Title of the active analog channel. 

Save Audio: Active saving the analog channel data to the window’s .WAV 
format. 

  Audio Filename: The path and name of the saved .WAV file. 
  Drives:   A list of all the connected drives.  Select the desired drive. 
 
Options: Play:   Play the active analog channels data. 

Volume:  Decrease/Increase the volume of the output. 
 
Comments: Marked channels are displayed in red. The “Active Channel” section displays the active 

analog channel in the data display window. The “Audio Controls” section allows for 
playing the active analog channel’s data through the computers speakers and for 
increasing/decreasing the volume of the output. The “Save .WAV File” section allows for 

saving the analog channel data in the Window’s .WAV format. Click the folder button  
to select and destination directory and to enter a new “.WAV” file or for selecting an 
existing “.WAV” file. The selected file path and name will be updated in the “Audio 
Filename” field. 

 
See Also:  Play Channels Audio in Chapter 1. 

PRIMARY VALUES 

Location: Data Display (Analog Table)  
 
Description: The values displayed in the analog table are either in primary or secondary quantities. If 

the file defines the type of values saved then the type is displayed in the window header. 
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Also, if the CT and PT ratios are defined in the configuration file then the values can be 
changed from primary to secondary and vice versa. To change the values open the 
properties dialog and click on the “Driver Data Type” tab, select the Primary or Secondary 
radio button to switch between values. 

  
See Also: Changing Analog Values in Chapter 1 

Secondary Values 

PRINT ALL DATA 

Location: Data Display 
 
Description: Print all the data for the visible analog and digital channels. 
 
Activation: Menu: Alt-F, P, A 
 
Comments: The printer must be registered in the system's WIN.INI file.  The printed pages include the 

page number and the date/time of the first sample in the page.  The channel information 
is printed at the end of the data.  Use the print page option to print only the contents of 
the data window. 

   
See Also: Printer Setup 

PRINT ALL ROWS 

Location: File Manager 
 
Description: Print all the files in active directory. 
 
Activation: Menu: Alt-F, P, A  
 
Comments: The printer must be registered in the system's WIN.INI file.  Use the Print Marked Rows 

option to print only the marked files. 
 
See Also:  Printer Setup 

PRINT DXF FILE 

Location: DXF Display 
 
Description: Print all the contents of the DXF file. 
 
Activation: Menu: Alt-F, P, F  
 
Comments: The printer must be registered in the system's WIN.INI file.  Use the Print “Page” option to 

print only the contents displayed in the window. 
 
See Also:  Printer Setup 

PRINTER SETUP 

Location: All child windows.  
 
Description: Change the printer type and setup the current printer. 
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Activation: Menu: Alt-F, S – File Manager/ASCII/Hex Editor 

Menu: Alt-F, S – Data Display 
Menu: Alt-F, S – DXF Display 

PRINT FILE 

Location: ASCII/HEX Editor 
 
Description: Print all the contents of the open file. 
 
Activation: Menu: Alt-F, P, F  
 
Comments: The printer must be registered in the system's WIN.INI file.  In the ASCII editor, use the 

Print File Page option to print the current page. 
 
See Also:  Printer Setup 

QUERY ALL FILES 

Location: Query Fields 
 
Description: Compare the entered criteria to all the files in the active directory. 
 

Activation: Direct: F6, <enter> or the Query menu button  
Menu: Alt-Q, A 

 
Comments: All the files in the active directory are compared to the entered query criteria.  A marked 

file that does not meet the query requirements is unmarked.  The files that meet the 
query requirements are marked and grouped at the top of the table.  Marked files are 
displayed in red. 

 
The <enter> key and the query menu button searches all the files in the table. 

 
See Also: Query Marked Files 

Query Unmarked Files 
Clear Query Criteria 

QUERY MARKED FILES 

Location: Query Fields 
 
Description: Compare the entered criteria to the marked rows in the active table. 
 
Activation: Direct: F5 

Menu: Alt-Q, M 
 
Comments: The marked rows that meet the query requirements are marked and grouped at the top of 

the table.  All other marked rows are unmarked.  Marked rows are displayed in red. 
 
See Also: Query Unmarked Files 

Query All Files 
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QUERY UNMARKED FILES 

Location: Query Fields 
 
Description: Compare the entered criteria to the unmarked rows in the active table. 
 
Activation: Direct: F7 

Menu: Alt-Q, U 
 
Comments: The unmarked rows that meet the query requirements are marked and grouped below 

previous marked rows.  Marked rows are displayed in red. 
 
See Also: Query Marked Files 

Query All Files 

RECORDED CHANNELS 

Location: Data Display 
 
Description: Display the following information for the active oscillography file: 

Channel # Analog Channel Titles  Full Scale Values 
SAC #  SAC Titles   Full Scale Values 
Channel # Digital Channel Titles  Original State Values 
SDC #  SDC Titles   Original State Values 

 
 

Activation: Direct: F2 - Channel menu button  
Menu: Alt-F, R 

 
Comments: Triggered digital channel titles are displayed in red.  All valid and invalid channels are 

displayed. 

REFERENCE BAR 

Location: Data Display 
 
Description: Displays the instantaneous sample value at the reference bar position (dotted blue line 

that runs vertically across the analog and digital channels).  This value is displayed in the 
RefVal column of the analog table view. 

 
Comments: The reference bar is used to resize the RMS sliding window and display the 

instantaneous value at the sample position.  To resize the sliding window, click the right 
mouse button to set the reference bar position and the left mouse button to set the data 

bar position then select the Set RMS Bar  menu button.   
 

The Delta time (Delta X) field, displayed in the status bar shows the time difference 
between the reference bar and the data bar.  If the time difference between the samples 
is in milliseconds or microseconds then the number of cycles between the two bars is 
also displayed. 
 
The default position of the reference bar is at the fault time. 

 
See Also:  Data bar 

RefVal 
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REFRESH 

Location: File Manager 
 
Description: Update the contents of the active directory from the operating system's allocation table. 
 

Activation: Direct: Refresh menu button  
Menu: Alt-F, F 

REFVAL COLUMN 

Location: Data Display (Analog Table)  
 
Description: Displays the sample value at the Reference bar (blue dotted line). 
 
Comments: If the active driver’s data type is set to RMS calibrated, the sample value at the data bar 

position is multiplied by the square root of 2. 
 
See Also: Viewing Analog Data in Chapter 1 

Reference Bar 

RENAME FILE/DIRECTORY 

Location: File Manager 
 
Description: Rename the file or directory at the cursor position. 
 
Activation: Menu: Alt-F, N 
 
Fields: From:  The current name of the file. 

To:  The new name of the file. 
 
Options: Enter/Ok: Change the name. 

Esc/Cancel: Exit the dialog without executing the command. 

REOPEN WAVEFORM FILE 

Location: Data Display 
 
Description: Reopen a file that was previously viewed. 
 

Activation: Menu Bar:  Open File drop down menu button  
 
Comments: A list of the last 14 open files is displayed in a drop down menu button.  Click the on the 

file to reopen. 
 
See Also: Reopen Waveform File in Chapter 1 

RESIZE FILE COLUMNS 

Location: File Manager 
 
Description: Resize the columns in the file table. 
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Activation: Direct: Left Mouse Drag 
 
Comments: To resize the table columns, place the mouse over the column separator and drag to the 

right or the left.  The cursor changes to the vertical resize cursor when the mouse is 
positioned over the column separator.  Double click the left mouse over the separators to 
make the column size the maximum area to display all the text in the column.  The fault 
date and time and save date and time columns are fixed and cannot be resized.  

RESIZE SLIDING WINDOW 

Location: Data Display 
 
Description: Resize the RMS sliding window. 
 

Activation: Direct: Resize Sliding Window menu button  
Menu: Alt-V, W 

 
Comments: To automatically resize the RMS sliding window click on the Resize Sliding Window 

menu button  or open the “Resize Sliding Window” menu option under the “View” 
menu. To manually resize the RMS sliding window click the right mouse button to set the 
reference position and the left mouse button to set the ending data position then click the 

SetRMS  menu button.  The RMS bar is moved to the reference position.  The Delta 
time (Delta X) field displayed in the status bar at the bottom of the screen shows the time 
difference (in milliseconds or seconds) and the number of cycles between the reference 
and data bars. Use the left, right, ctrl+left, and ctrl+right keys or the horizontal scroll bar 
to move the sliding window.  

 
See Also: Setting the Cursor Bars in Chapter 1 

Data Bar 
RMS Bar 
Reference Bar 

RESTORE MARK(S)  

Location: Data Display 
 
Description: Restore all the hidden analog channels.  The delete key removes the marked analog 

channels and the insert key restores the channels. 
 

Activation: Direct: Insert or the ViewAll menu button  
Menu: Alt-C, R 

 
See Also: View Mark(s) 

Hide Mark(s) 
Show All Hidden 

RESTORE ORIGINAL DATA  

Location: Data Display 
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Description: Restore the displayed file to the original samples stored in the file.  This feature will undo 
all changes made using the change frequency, duplicate cycles and truncate cycles 
features. 

 

Activation: Direct: Restore Original Data menu button  
Menu: Alt-D, R 

 
See Also: Duplicate Cycles 

Truncate Cycles 
Change Frequency 

RMS COLUMN 

Location: Data Display (Analog Table)  
 
Description: Displays the RMS value for all samples positioned between the RMS bar (black dotted 

line) and the data bar (black solid line).  If the data is RMS calibrated, each sample value 
is multiplied by the square root of 2 before it is squared. 

  
See Also: Viewing Analog Data in Chapter 1 

RMS Bar 
Data Bar 

RMS BAR 

Location: Data Display 
 
Description: The RMS bar is the black dotted line that runs vertically across the analog and digital 

channels.  The RMS bar and data bar define the RMS sliding window.   
 
Comments: When the data display is initially opened the sliding window is defaulted to one cycle.  

The sliding window is used to calculate the RMS value for all samples positioned 
between the data bar and the RMS bar.  This value is displayed in the Analog View.   

 
To resize the sliding window, click the right mouse button to set the reference bar position 
and the left mouse button to set the data bar position then select the Set RMS Bar menu 
button.  This button will move the RMS bar to the reference bar. 
 

See Also:  Data bar 
RMSVal Column 
TrueRMS Column 

RUN 

Location: File Manager 
 
Description: Execute the specified command. 
 
Activation: Direct: F5 

Menu: Alt-F, R 
 
Fields: Open:  The path and filename of the application to run. 
 
Options: Enter/Ok: Run the specified application. 
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Esc/Cancel: Exit the dialog without executing the command. 
Browse: Display the Windows open dialog to browse for a file.  

SAMPLE BASED DISPLAY  

Location: Data Display 
 
Description: The sample base display plots the channel data with 1 pixel distance between each 

displayed sample.  Sample based displays are useful for showing changes in sampling 
frequency. 

 
Comments: To change the trace display settings open the “Window Properties” dialog under the “File” 

menu.  Click the “Display Settings” tab and change the “Trace Display Type” field to time 
based or sample based. 

 
See Also: Time & Sample Based Displays in Chapter 1 

SAVE AS 

Location: ASCII/Hex Editor 
 
Description: Save the active file to a new name. 
 
Activation: Menu: Alt-F, A 
 
See Also: Save As Text 

SAVE AS COMTRADE (ASCII/BINARY)  

Location: File Manager & Data Display 
 
Description: Save the waveform file at the cursor position or the displayed analog/digital channels to 

COMTRADE ASCII or Binary format. 
 
Activation: Menu: Alt-O, V, A – Save in COMTRADE ASCII format 

Menu: Alt-O, V, B – Save in COMTRADE Binary format 
 
Fields: Path:  The destination path. 

Filename: The filename with no extension. 
 
Options: Enter/Ok: Read the file contents and save it in COMTRADE format. 

Esc/Cancel: Exit the dialog without executing the command. 
 
Comments: Do not enter a filename extension.  The COMTRADE configuration (.CFG) and data 

(.DAT) files are automatically created.  If a path is not defined, the files are saved in the 
active directory.   
 
Currently there are two Comtrade versions supported: the older 1991 format and the 
newer 1999 format.  The Comtrade format can be selected from the “Window Properties” 
dialog in the data display window.  The default format is the newer 1999 format.   
 
If the sample values in the selected file are RMS calibrated and the outcome Comtrade 
file must have instantaneous values then set the “Comtrade Settings” fields to 
automatically convert the RMS data to instantaneous values.  To set the “Comtrade 
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Settings” fields open the “Window Properties” dialog in the data display window.  Select 
the “Comtrade” tab then select “Yes” for the “Convert RMS Calibrated Data to Peak Data” 
field. 
 
To automatically convert the selected channels to Comtrade using the IEEE long file 
naming convention check the “Use the ComNames Naming Convention to Name the 
Comtrade File(s)” field in the “Save As Comtrade” Dialog and leave the File Name field 
empty.  The selected channels are converted to the selected Comtrade format and are 
named using the IEEE long file naming convention. 

 
Restrictions: The selected file must be a supported oscillography file. 
 
See Also: Save As Comtrade in Chapter 1 

SAVE AS TEXT 

Location: Hex Editor 
 
Description: Save the binary values in the hex editor to an ASCII text file. 
 
Activation: Menu: Alt-F, T 
 
See Also: Save As 

SAVE DATE COLUMN 

Location: File Manager 
 
Description: Displays the date the file was last saved on disk. 
 
Comments: Click the table’s Save Date header to sort the files in ascending or descending order with 

respect to the Save Date. 
 
See Also: Fault Date/Time Column 

Save Time 

SAVE DISPLAYED VALUES (DEFAULT FORMAT) 

Location: Data Display 
 
Description: Save the displayed values in the analog table to a file or to the Windows clipboard. 
 
Activation: Menu: Alt-F, T “Values File” Tab 
 
Fields: Save To:  Where to save the values: file, clipboard or both 

Select Values File: Select the file for the displayed values. 
Save Type:  How to maintain the file: append or rewrite 
Save Format:  How to save the data: fixed ASCII or comma delimited 
Add Titles:  Add the titles to the file or no titles. 

 
Options: Enter/Ok:  Set the format. 

Esc/Cancel:  Exit the dialog without executing the command. 
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Comments: To save the samples values to a file select the “Mark & Save” menu option under the 
“Values” menu.  Select the format for the selected sample.  To view the values file, select 
the “Values File/Open” menu option under the “Values” menu. 

 
See Also: Save Displayed Values in Chapter 1 

SAVE TIME COLUMN  

Location: File Manager 
 
Description: Displays the time the file was last saved on disk. 
 
Comments: Click the table’s Save Time header to sort the files in ascending or descending order with 

respect to the Save Time. 
 
See Also: Fault Date/Time Column 

SAVE USER VIEWS 

Location: Data Display 
 
Description: Save the displayed view information in an ASCII text file. 
 
Activation: Menu: Alt-V, S 
 
Fields: View File Path: Destination path for the file. 

View Name: The name of the view. A file extension is not needed. The “.VIW” 
extension is automatically assigned. 

 
Options: Enter/Ok: Save the view. 

Esc/Cancel: Exit the dialog without executing the command. 
 
Comments: The following information is saved: 

• Displayed analog channels, 

• Analog channel order, 

• Superimposed channels, 

• Analog channel colors, 

• Digital channels displayed, 

• Sampling frequency, 

• Time scale, 

• Sliding window size (RMS bar to Data bar), 

• Phasor window size, 

• Table window size, 

• Red fault bar, 

• Auto scale and 

• Phasor or circular chart displayed 
 
See Also: Select User Views 

User Views in Chapter 1 

SECONDARY VALUES 

Location: Data Display (Analog Table)  
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Description: The values displayed in the analog table are either in primary or secondary quantities. If 

the file defines the type of values saved then the type is displayed in the window header. 
Also, if the CT and PT ratios are defined in the configuration file then the values can be 
changed from primary to secondary and vice versa. To change the values open the 
properties dialog and click on the “Driver Data Type” tab, select the Primary or Secondary 
radio button to switch between values. 

  
See Also: Changing Analog Values in Chapter 1 

Primary Values 

SELECT USER VIEWS 

Location: Data Display 
 
Description: Select a view file from the list of files located in the displayed view path. 
 
Activation: Menu: Alt-V, V 
 
Fields: View Files:  A list of all the view files in the displayed view path. 

Analog Channels: All analog channel information defined in the view file. 
Digital Channels: All digital channel information defined in the view file. 

 
Options: Enter/Ok:  Select the highlighted view. 

Esc/Cancel:  Exit the dialog without executing the command. 
 
Comments: The following information is read from the selected view file and applied to the displayed 

file: 

• Displayed analog channels, 

• Analog channel order, 

• Superimposed channels, 

• Analog channel colors, 

• Digital channels displayed, 

• Sampling frequency, 

• Time scale, 

• Sliding window size (RMS bar to Data bar), 

• Phasor window size, 

• Table window size, 

• Red fault bar, 

• Auto scale and 

• Phasor or circular chart displayed 
 
If the analog channel and digital channel names defined in the view file are not in the 
displayed file than an error message is displayed. 

 
See Also: Save User Views 

User Views in Chapter 1 

SEQUENCE OF EVENTS LIST 

Location: File Manager 
 
Description: View a table of sequence of events for a number of waveform files.  Mark all the desired 

files then press F11 or select the "SOE List" menu option from the "Reports" submenu 
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under the "Options" menu.  A table will be displayed listing all the events triggered in the 
selected files. 

 
Activation: Direct: F11 

Menu: Alt-O, R, S 
 
Fields: Substation:  The substation where the device is installed. 

Device:   The device the channel came from. 
State:   The state of the channel at that time (A=Abnormal, N=Normal). 
Trigger Date:  The trigger date. 
Trigger Time:  The trigger time. 
Channel:  The channel number of the event in the file. 
Channel Title:  The title of the channel. 
File:   The file containing the event/sensor channel. 

 
Comments: The table is sorted according to the date and time.  The Query section at the bottom of 

the table allows for searching events from specific substations, devices, channels and 
more...  To view the file containing the specific events press enter or double click on the 
event. 

SEQUENCE OF EVENTS SUMMARY 

Location: File Manager 
 
Description: View a table of summarizing the sequence of events for a number of waveform files.  

Mark all the desired files then select the "SOE Summary" menu option from the "Reports" 
submenu under the "Options" menu.  A table will be displayed listing a summary of the 
events triggered in the selected files. 

 
Activation: Menu: Alt-O, R, O 
 
Fields: Substation:  The substation that triggered the event/sensor 

Device:   The device the channel originated from. 
Fst-State:  The state the channel started at, A=alarm and N=normal. 
Lst-State:  The state the channel ended at, A=alarm and N=normal. 
First Change Date  The date the channel first changed state. 
First Change Time: The time the channel first changed state. 
Last Change Date  The date the channel last changed state. 
Last Change Time: The time the channel last changed state. 
Changes:  The number of times the channel changed state. 
Chan#:   The channel number in the file. 
Channel Title:  The title of the channel. 
File:   The file containing the event/sensor channel. 

 
Comments: The table is sorted according to the first change date and time.  The Query section at the 

bottom of the table allows for searching events from specific substations, devices, 
channels and more...  To view the file containing the specific events press enter or 
double click on the event. 

SET DRAWING CONSTANTS  

Location: CAD-DXF Display 
 
Description: Set the DXF drawing’s constants. 
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Activation: Direct: F2 - Const menu button  
Menu: Alt-F, D 

 
Fields: File Name:  The file name for the currently select file. 

Background Color: The color for the background . 
Max X Pixel:  The maximum X resolution value. 
Max Y Pixel:  The maximum Y resolution value. 

 
Options: Enter/Ok:  Exit the dialog, then save and execute the entered information. 

Esc/Cancel:  Exit the dialog without saving the information. 
Apply: Apply and save the entered parameters without closing the 

dialog. 
 
Comments: The Max X Pixel and Max Y Pixel values cannot exceed 32000.  The “···” button allows 

for changing the active file. 

SET OPENING FREQUENCY  

Location: Data Display 
 
Description: Set a driver’s open frequency.  This feature is available in the “Change Frequency” 

dialog. 
 

Activation: Direct: Change Frequency menu button  
Menu: Alt-D, F 

 
Fields: Open Frequency: Specify to always open the files associated with the active driver 

using the entered frequency. 
 
Options: Enter/Ok:  Exit the dialog, then save and execute the entered information. 

Esc/Cancel:  Exit the dialog without saving the information. 
 
Comments: Setting the Always Open field will open all files associated with the active driver using the 

entered frequency.  This feature is useful for files with low sampling frequency. 
 
See Also: Change Frequency 

SET SORT FIELD 

Location: All Tables 
 
Description: Set the active sort field to the column at the cursor position. 
 
Activation: Direct: Left Mouse Click on the Column’s header 

Menu: Alt-S, S  
 
Comments: The “Ascending” and “Descending” options in the “Sort” menu sorts the table data with 

respect to the select sort field.  To sort the columns directly, click the column header 
button to toggle between ascending and descending. 

 
See Also: Sort All Rows 
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SHIFT MARKS DOWN 

Location: Data Display 
 
Description: Shift all the marked analog channels down one position. 
 
Activation: Direct: "-" key 

Menu: Alt-C, D 
 
Comments: Individual channels can be marked or unmarked by clicking on the channels 

corresponding display ID or channel information or by pressing the spacebar.  Marked 
analog channels are displayed in red. 

 
See Also: Shift Marks Up 

SHIFT MARKS UP 

Location: Data Display 
 
Description: Shift all the marked analog channels up one position. 
 
Activation: Direct: "+" key 

Menu: Alt-C, U 
 
Comments: Individual channels can be marked or unmarked by clicking the channels corresponding 

display ID or channel data, or by pressing the spacebar.  Marked analog channels are 
displayed in red. 

 
See Also: Shift Marks Down 

SHOW/HIDE CHANNEL TITLES 

Location: File Manager 
 
Description: The Show/Hide Channel Titles allows for showing invalid channel titles, remove titles 

from the invalid title list and adding new titles to the invalid channel title list. 
 
Activation: Menu: Alt-O, T 
 
Fields: Title List Box:  Lists all invalid channel titles. 

Add Title:  Add a new title to the list. 
Remove Title:  Remove a title from the list. 

 
Options: Enter/Ok:  Execute changes. 

Esc/Cancel:  Exit the dialog without executing the command. 
 
Comments: To show a title, uncheck the checkbox next to the title. All new titles are added to the end 

of the list with the checkbox automatically checked. 
 
See Also: Show/Hide Channel Titles in Chapter 1 

SHOW ALL DIGITAL CHANNELS 

Location: Data Display 
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Description: Show all digital channels or just the triggered digital channels.  This menu option toggles 
between the two views. 

 
Activation: Direct: F9 

Menu: Alt-V, D 
 
Comments:   Placing the mouse on the horizontal separator bar and dragging it up or down can resize 

the digital channel display area.  The cursor changes to the horizontal resize cursor when 
the mouse is positioned over the bar. 

SHOW ALL HIDDEN 

Location: Data Display 
 
Description: Show all hidden analog and digital channels. 
 

Activation: Direct: ViewAll menu button  , the <esc> key or the <backspace> key 
Menu: Alt-C, S 

 
See Also: View Mark(s) 

Hide Mark(s) 
Restore Mark(s) 

SHOW CHANNEL INFORMATION 

Location: Data Display 
 
Description: Show or hide the channel information window.  This menu option toggles between the 

two views. 
 
Activation: Menu: Alt-V, C 
 
Comments: The channel information window can be resized by placing the mouse on the vertical 

separator bar and dragging it to the right or the left.  The cursor changes to the vertical 
resize cursor when the mouse is positioned over the bar. 

SIZE 

Location: File Manager (Status Field) 
 
Description: Displays the total size (in Kbytes) of all files in the active directory.   
 
See Also: Free 

MrkSize 

SIZE COLUMN 

Location: File Manager 
 
Description: Displays the size (in bytes) of the file.   
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SIZE TO ORIGINAL COORDINATES 

Location: DXF Display 
 
Description: Size the DXF drawing to the original display coordinates (coordinates of the drawing 

when the file was first opened).   
 

Activation: Direct: Original Display menu button  
Menu: Alt-V, Z 

 
Comments: The Max X and Max Y Pixel values in the Set Drawing Constants Dialog are updated 

according to the new coordinates. 

SIZE TO WINDOW 

Location: DXF Display 
 

Description: Size the DXF drawing to fit in the window.     
 

Activation: Direct: Fit in Window menu button  
Menu: Alt-V, W 
 

Comments: The Max X and Max Y Pixel values in the Set Drawing Constants Dialog are updated 
according to the new coordinates. 

SOFTWARE ANALOG CHANNELS 

Location: Data Display 
 
Description: Display the software analog channel dialog. 
 
Activation: Direct: F5 

Menu: Alt-C, A 
 
Fields: Titles:  The titles for the software analog channels. 

Operators: Each analog operation followed by an operator terminator “/”. 
 
Options: Enter/Ok: Exit the dialog then save and execute the operators. 

Esc/Cancel: Exit the dialog without saving or executing the operators. 
F1/Help: Display the help window. 

 
Comments: Software analog channels (SAC's) are extra channels provided by the system.  These 

channels can be used to calculate a missing phase, create +, - and 0 sequence 
channels, create an envelope of a selected trace, or define an under/over-trigger values 
to monitor a given channel.  The SAC window is split into two sections: the titles and the 
operators.  To navigate between fields use the tab, up arrow and down arrow keys. 

 
See Also: Creating Virtual Channels in Chapter 1. 

SOFTWARE DIGITAL CHANNELS  

Location: Data Display 
 
Description: Display the software digital channel dialog. 
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Activation: Menu: Alt-C, D 
 
Fields: Titles:  The titles for the software digital channels. 

Operators:  Each digital operation followed by an operator terminator “/”. 
 
Options: Enter/Ok: Exit the dialog then save and execute the operators. 

Esc/Cancel: Exit the dialog without saving or executing the operators. 
F1/Help: Display the help window. 

 
Comments: Software digital channels (SDC's) are extra channels provided by the system.  The SDC 

window is split into two sections: the SDC titles, and the SDC operators.  To navigate 
between fields use the tab, up arrow and down arrow keys. 

 
See Also: Creating Virtual Channels in Chapter 1. 

SORT ALL ROWS 

Location: File Manager 
 
Description: Sort all the rows in the table in ascending or descending order.  
 
Activation: Direct: Column headers 

Menu: Alt-S, A – Ascending 
Menu: Alt-S, D – Descending 

 
Comments: All the rows in the directory are sorted with respect to the sort field displayed in the 

table’s status field. 
 
See Also: Set Sort Field 

SORT MARKED ROWS 

Location: File Manager 
 
Activation: Menu: Alt-S, M 
 
Description: Sort the marked files according to the previously selected sort order.  
 
Comments: All marked files are sorted and grouped at the top of the table. 

SUBSTATION COLUMN  

Location: File Manager 
 
Description: Displays the substation name associated with the long file name.  The fourth field in the 

file name defines the substation field for the IEEE long file-naming format.     
 
See Also: Long File Naming Format in Chapter 1. 

SUPER IMPOSE 

Location: Data Display 
 
Description: Superimpose all or marked analog channels. 
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Activation: Direct: F7 

Menu: Alt-D, S 
 
Comments: Marked channels are superimposed and grouped at the top of the display window.  The 

superimpose menu option and the F7 function key toggles superimposing on and off. 

SYNC DATA CURSORS  

Location: Data Display 
 
Description: Synchronize the data cursors for two or more open display windows by time or manually.     
 
Activation: Menu: Alt-D, Y, T – “By Time” 

Menu: Alt-D, Y, M – “Manually” 
 
Options: By Time: When the "By Time" sync cursor feature is turned ON the data cursors in the 

non-active windows are moved to the sample value time in the active 
window.  For example if the active data cursor is positioned on sample time 
01:12:34.560, all non active data cursors are moved to the sample value at 
that time.  If the time is not found in the non-active window, the cursor 
position is unchanged.  The active window defines the master data cursor 
and all other cursors follow this position.   

Manually: This feature allows for selection of different cursor positions in the open data 
windows before synchronization is turned ON.  For example, open two data 
windows and tile horizontally, move the data cursors to the beginning of the 
fault cycles, and select the sync manual cursor option.  When the left, right, 
ctrl-left, ctrl-right, page up, page down, ctrl-page up, ctrl-page down, home 
and end keys are pressed the data cursors move simultaneously. 

   
Comments: A check mark indicates that the sync feature is ON.  To turn synchronizing OFF click on 

the active sync menu option to remove the check mark.  When synchronizing is ON the 
channel information displayed to the right of the traces is updated for all open data 
windows. 

 
See Also: Synchronizing Data Cursors in Chapter 1. 

TAB DELIMITED TABLE DRIVER  

Location: File Manager 
 
Description: Display the tab delimited file at the cursor position in a table format.  Tab delimited files 

have textual fields separated by blank spaces, such as: CHANNEL DATE TIME. 
 
Activation: Menu: Alt-D, 3, T 
 
Comments: The data in the file is presented in tabular form.  An unlimited number of rows and 

columns can be displayed. 
 
See Also: Viewing ASCII Files in Database Format in Chapter 1. 

Double Quotes/Comma Delimited Table Driver 
Comma Delimited Table Driver 
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TCODE COLUMN  

Location: File Manager 
 
Description: Displays the TCode associated with the long file name.  The third field in the file name 

defines the TCode field for the IEEE long file-naming format.  This field represents the 
time code of the substation with respect to Greenwich Time. 

 
See Also: Long File Naming Format in Chapter 1. 

TIME BASED DISPLAY  

Location: Data Display 
 
Description: The time base display plots the channel data in time.  Time base displays are useful for 

showing changes in line frequency. 
 
Comments: To change the trace display properties open the “Window Properties” dialog under the 

“File” menu.  Click the “Display Settings” tab and change the “Trace Display Type” field to 
time based or sample based. 

 
See Also: Time & Sample Based Displays in Chapter 1 

TIS DRIVER 

Location: File Manager 
 
Description: Change the driver at the cursor position to the TIS driver and plot the input channels. 
 
Activation: Menu: Alt-D, S 
 
Comments: The TIS file format is an ASCII comma delimited format with the channel information 

defined in the first line of the file. If the selected is not an ASCII comma delimited file then 
an error message is generated.  All files that have a ”.TIS” extension are tagged as TIS 
files. 

 
See Also: Associating File Types in Chapter 1. 

TOTAL HARMONICS DISTORTION 

Location: Data Display (Harmonics Dialog)  
 
Description: The "Total Harmonic Distortion" field displays the square root of the summation of the 

squares of DFT Magnitudes for harmonics 2 to n divided by square root of 2 and that 
quantity divided by the DFT Magnitude of the Fundamental.  

   
See Also:  Harmonics 

Histogram 

TOTFILES 

Location: File Manager (Status Field)  
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Description: Displays the total number of hidden and unhidden files/directories in the active directory.  
The ”.” and “..” navigation shortcuts are included in the unhidden total.  

 
See Also:  TotMarks 

TOTMARKS 

Location: All Tables (Status Field)  
 
Description: Displays the total number of marked rows in the active table.  Marked rows are displayed 

in light red.  

TRACE SCALE MULTIPLIER (ASM) 

Location: Data Display (Window Properties Dialog)  
 
Description: Used as a multiplier to increase/decrease the amplitude of the visible analog channels 
 
Activation: Menu: Alt-F, T 
 
Range: Greater Than 1.00 
 
Default: 2.00 
 
Comments: When a channel's amplitude is increased, the trace scale value is multiplied with the 

Pixsdisp value, and when the channel's amplitude is decreased the trace scale value is 
divided by the Pixsdisp value . 

TRIGGER-TIME  

Location: Waveform Summary (Events/Sensors Activity Log)  
 
Description: Displays the time the digital channel changed state.  This value is displayed in the third 

column of the Events/Sensors Activity Log.   
 
Comments: The Events/Sensors Activity Log displays a time-sequenced list of all the events and 

sensors activity. 

TRUERMS 

Location: Harmonics Table (Data Display)  
 
Description: Displays the RMS value for all the samples between the RMS bar (black dotted line) and 

the data bar (black solid line). 
  
Comments: This value is taken directly from the RMS column inside the analog information table.  
 
See Also: Harmonics Table 

TRUNCATE CYCLES 

Location: Data Display 
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Description: Remove beginning, middle or end cycles from the active data display window. 
 
Activation: Menu: Alt-D, T, L: Left-Start to Data Bar 

Menu: Alt-D, T, R: Data Bar to End 
Menu: Alt-D, T, M: Data Bar to Reference Bar 

 
Comments: There are 3 options available under the Truncate Cycle’s menu option.  Left removes the 

cycles from the first sample to the data bar (solid black vertical line).  Right removes the 
cycles from the data bar to the last sample.  Middle removes the cycles from the data bar 
to the reference bar (dotted blue vertical line) 

 
See Also: Truncate Cycles in Chapter 1 

TYPE COLUMN  

Location: File Manager 
 
Description: Displays the fault type associated with the long file name.  The eighth field in the file 

name defines the type field for the IEEE long file-naming format.  This field represents the 
fault type or contents type of the file. 

 
See Also: Long File Naming Format in Chapter 1. 

UN/MARK FILE 

Location: All Tables 
 
Description: Mark or unmark the row at the cursor position. 
 
Activation: Direct: Spacebar - Ctrl-Left Mouse Button 

Menu: Alt-M, M 
 
Comments: Marked rows are displayed in red.  The TotMarks field displayed in the status bar is 

updated accordingly. 
 
See Also: Unmarked Marks 

Group Marked Rows 

UNMARK MARKS 

Location: All Tables 
 
Description: Unmark all the marked rows in the table. 
 

Activation: Direct: Mark menu button (if marked files>0) . 
Menu: Alt-M, U 

 
Comments: Marked rows are displayed in red.  The TotMarks field, displayed in the status bar, is 

updated accordingly. 
 
See Also: Mark/Unmark File 

Group Marked Files 
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VIEW MARK(S) 

Location: Data Display 
 
Description: Hide all the unmarked channels and resize the marked channels. 
 
Activation: Direct: Enter 

Menu: Alt-C, V 
 
Comments: Individual channels are marked and unmarked by clicking the left mouse button on the 

channel’s corresponding display ID or channel information or by pressing the spacebar.  
Marked channels are displayed in red. 

 
See Also: Hide Mark(s) 

Show All Hidden 
Restore Mark(s) 

VIEW RAW DATA FILE 

Location: Data Display 
 
Description: View the contents of the active displayed file in an ASCII editor or a hexadecimal editor. 
 

Activation: Direct: Menu button  
Menu: Alt-F, V 

 
Comments: The waveform file is displayed in an ASCII editor if the contents of the file are in text 

format and displayed in a hex editor if the file is in binary format. 
 
See Also: Viewing/Modifying ASCII Files 

Viewing/Modifying Binary Files 

WAVEFORM DATA 

Location: File Manager 
 
Description: Plot the contents of the event file at the cursor position or if there are marked waveform 

files, plot all marked. 
 

Activation: Direct: <enter>, Plot menu button  
Menu: Alt-O, W, O 

 
Comments: A maximum of 10 oscillography/log files can be opened simultaneously. 

WAVEFORM SUMMARY 

Location: File Manager & Data Display 
 
Description: Generates and displays analog and digital summaries for the active file in the file table or 

the data display. 
 

Activation: Direct: Sum menu buttons  - File Table,  - Data Display  
Menu: Alt-O, S – File Table, Alt-F, S – Data Display 
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Comments: The summary file displays the following information: 
  

Waveform Information 
Station: Name of the Station associated with the waveform. 
Filename: The name of the waveform file. 
File Size: The size of the file in kilobytes. 
Prefault-Time: The date and time of the first prefault sample. 
Fault-Time: The date and time of the first fault sample. 
Save-Time: The date and time the file was saved to hard disk. 
Process-Time: The date and time the file was processed into this summary. 
Start Date & Time: Date and time of the first sample in the file. 
End Date & Time: Date and time of the last sample in the file. 
File Duration: Duration of the file measured in days, hours, seconds, milliseconds and/or 

microseconds, depending on the type of file. 
Sampling Frequency: Sampling frequency and the time between each sample. 
Line Frequency: Line Frequency defined in the file. 
 
Fault Information 
Fault Information is displayed if there is fault information contained in the *.HDR file. The 

fault information must begin with “Events:”. 
 
Highest/Lowest Analog Peak Chart 
HPeak-Up: The highest positive peak. 
HPeak-Dn: The highest negative peak. 
LPeak-Up: The lowest positive peak. 
LPeak-Dn: The lowest negative peak. 
OneBit: The channel's full-scale value divided by the channel's resolution. 
pU: The channel's prefix and units. 
Description: The number and title of the channel. 
HP-Dif: The (absolute value of the HPeak-Up minus the absolute value of the HPeak-Dn) 

divided by the OneBit value. 
LP-Dif: The (absolute value of the LPeak-Up minus the absolute value of the LPeak-Dn) 

divided by the OneBit value. 
 

Events/Sensors Activity Summary 
Fst: The state the channel started at, A=alarm, N=normal. 
Lst: The state the channel ended at, A=alarm, N=normal. 
Fst-Change: The date and time the channel first changed state. 
Lst-Change: The date and time the channel last changed state. 
Changes: The number of times the channel changed state. 
Description: The number and title of the channel. 
 
Events/Sensors Activity Log 
State: The state of the channel at the triggered time, A=alarm, N=normal. 
Trigger Time: The time the channel changed state. 
Description: The number and title of the channel. 

 
Note: An xx:xx:xx.xxx in the events/sensors activity summary indicates that the digital channel's 

state did not change from the initial state (Fst). 

WINDOW PROPERTIES 

Location: Data Display 
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Description: Reposition the columns in the analog table, change the fields displayed in the 
combination view, change the background colors and trace colors; change the driver’s 
data type, change the trace/phasor scale multipliers and more.  Refer to the fields below. 

 

Activation: Direct: Menu Button  
Menu: Alt-F, T 

 

Fields: Analog Table Tab:  Reorder/Show/Hide the columns in the analog table. 
 Analog Combination Tab: Change the display positions in the analog combination 

view. 
 Comtrade:  Define the Comtrade format for saving, the date and 

time format for display and set automatic conversion 
from RMS data to Peak data when using the “Save As 
Comtrade” feature. 

 Colors: Change the background colors and trace colors. 
 Values File: Format the save displayed values feature. 
 Display Settings: Change the trace/phasor scale multipliers and set 

general display properties. 
 Append/Merge: Set the append/merge properties. 
 Driver Data Type: Set the current display driver’s data type to Peak type or 

RMS calibrated. 
Filters: Define to delete spikes and set up spike properties 

 
Options: OK:  Apply the selected changes and redraw the data display. 

Cancel:  Exit the dialog without executing the changes. 
 
Comments: All data windows are defaulted to the display settings.  The analog data columns depend 

on the data type specified. 
 
See Also:  Customizing the data display in Chapter 1 

Viewing Analog Data in Chapter 1 

ZIP FILES 

Location: File Manager  
 
Description: Zip a group of files or a single file using the “Zip Marked Files” option under the “File” 

menu. All support files needed to display the selected files will be automatically included 
in the zip file.  Support files include Comtrade configuration (*.CFG), header (*.HDR) & 
information (*.INF) files, DFR’s analog and digital information files such as: Hathaway 
DAU files, Rochester preamble and header files, Faxtrax/Director CTL files, Transcan 
SCF and TCF files. 

 

Activation: Direct: Right Click Pop-up menu Button  
Menu: Alt-F, Z 

 
Fields: New Zip File Name: Enter a path and name for the new zip file. 

EncryptHeaders: Click to encryptheaders. 
 
Comments: To zip files, mark the desired files in the file table and select the “Zip Marked Files” option 

from the “File” menu or right click on the file table and select the “Zip” option from 
the pop-up menu.  All support files needed to display the file(s) are automatically 
included. 
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See Also: Zip Files in Chapter 1. 

ZOOMING 

Location: DXF Display 
 
Description: Change the DXF display viewing area. 
 

Activation: Direct: “+” & “-“ keys, Menu buttons  &  
Menu: Alt-V, I, O 

 
Comments: To zoom in press the “+” key, to zoom out press the “-“ key or use the Zoom In and Out 

menu buttons to change the viewing area.  If the Max X and Max Y variables, inside the 
status bar, are at 32000 then this feature is not be available 

ZOOM IN 

Location: DXF Display 
 
Description: Increase the drawing's resolution by multiplying the Zoom IN/OUT Ratio constant with the 

current X, Y resolution. 
 

Activation: Direct: “+” key, Menu buttons  
Menu: Alt-V, I 

 
Comments: The Max X and Max Y variables inside the status bar are updated accordingly.  The 

zoom in/out ration constant can be directly changed via the Zoom Scalar menu button. 
 
Restrictions: The Max X and Max Y resolution values cannot exceed 32000. 

ZOOM SCALAR  

Location: DXF Display  
 

Activation: Menu: Menu button  
 
Description: The Zoom Scalar Ratio constant is used to increase or decrease the drawing's display 

resolution.  The Zoom features multiples/divides the drawing's X and Y resolution values 
by the Zoom Scalar to increase/decrease the resolution. 

 
Range: Greater than 1.00 
 
Default: 2.50 

ZOOM OUT 

Location: DXF Display 
 
Description: Decrease the drawing's resolution by dividing the Zoom Scalar constant by the current X, 

Y resolution. 
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Activation: Direct: “-” key, Menu buttons  
Menu: Alt-V, O  

 
Comments: The Max X and Max Y variables inside the status bar are updated accordingly.  The 

zoom in/out ration constant can be directly changed via the Zoom Scalar menu button. 

ZOOM X, Y RESOLUTION CONSTANTS 

Location: DXF Display (Drawing Constants Dialog)  
 

Activation: Direct: F2 - Const menu button  
Menu: Alt-F, D 

 
Description: Set the drawings max X and max Y resolution values. 

Max X Pixel:  The maximum X resolution value. 
Max Y Pixel:  The maximum Y resolution value. 

 
Range: Less than 32000 
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Save Displayed Values: Format Files 
 
The format files listed in the “Mark & Save” menu option in the data display window allows for customizing 
ASCII sample files for playback into simulation and modeling applications.  The format files are tag based.  
The available tags are listed in the “Save Displayed Values” section in chapter 1.  All format files must have 
a “.FMT” extension and must be saved to the active Wavewin directory to show up in the “Mark & Save” 
menu option.  Below are some examples of format files and their results when used. 

Script Commands & Results 

Example 1: 
% Branch Identification 
 
Save as '<station>' as Substation 
Save as '387' as branch_identifier 
 
% Prefault Quantities 
 
save rect( <1> ) as I_kVa              
save rect( <2> ) as I_kVb 
save rect( <3> ) as I_kVc 
save rect( <4> ) as I_Ia 
save rect( <5> ) as I_Ib 
save rect( <6> ) as I_Ic 

 
The channel position <1> tag places all the displayed column data for the first visible channel in that 
position, separated by commas.  The <2> tag places the column data for the second visible channel 
and so on... 
 
Result 1: 

% Branch Identification 
 
Save as ' Arkey ' as Substation 
Save as '387' as branch_identifier 
 
% Prefault Quantities 
 
save rect( 65.859,0.000 ) as P_kVa 
save rect( 65.487,239.404 ) as P_kVb 
save rect( 65.779,119.194 ) as P_kVc 
save rect( 1.163,182.891 ) as P_Ia 
save rect( 0.984,56.515 ) as P_Ib 
save rect( 0.922,308.324 ) as P_Ic 

 
 
Example 2 (CVS format): 

<Date>, <Time>, <1>, <2>, <3>, <4>, <5>, <6>  
 
Result 2: 

01/05/2002 , 16:00:58.297001 
,65.859,0.000,65.487,239.404,65.779,119.194,1.163,182.891,0.984,56.515,0.922,308.324 
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01/05/2002 , 16:00:58.363168 
,66.163,0.000,58.410,230.927,43.068,90.845,0.841,172.201,1.823,43.631,6.714,36.394 
01/05/2002 , 16:00:58.467320 
,49.464,0.000,55.965,196.688,7.190,313.356,0.013,239.559,0.065,315.538,0.028,77.032 

 
 
Example 3 (Fault Report): 

Fault Report 
 
Station = <station> 
Date    = <Date> <Time> 
 
Karry 230kV  
----------------- 
<^4> 
<^35> 
<^5>    
<^6> 
 
Box Cr 230kV 
------------------- 
<^7> 
<^36> 
<^8>    
<^9> 
 
Dgl 1 230kV  
----------------- 
<^10> 
<^33> 
<^11>    
<^12> 
 
Dgl 2 230kV  
----------------- 
<^13> 
<^34> 
<^14>    
<^15>  

 
The channel position <^4> tag places all the displayed column data for the fourth channel in the 
window, separated by commas.  The <^35> tag places the column data for the thirty fifth channel and 
so on... 
 
Result 3: 

Fault Report 
 
Station = South Power Company 
Date    = 07/23/1999 16:41:29.510832 
 
Karry 230kV 
----------------- 
Karry 230kV Ph 1 Cur, 1.012, 71.969 
Karry 230kV Ph 2 Cur, 1.010, 12.023 
Karry 230kV Ph 3 Cur, 1.007, 312.760 
Karry 230kV Res  Cur, 0.025, 53.267 
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Box Cr 230kV 
------------------- 
Box Cr 230kV Ph 1 Cur, 0.232, 83.134 
Box Cr 230kV Ph 2 Cur, 0.218, 22.161 
Box Cr 230kV Ph 3 Cur, 0.217, 320.950 
Box Cr 230kV Res  Cur, 0.018, 110.258 
 
Dgl 1 230kV 
--------------- 
Dgl 1 230kV Ph 1 Cur, 0.434, 256.083 
Dgl 1 230kV Ph 2 Cur, 0.443, 196.842 
Dgl 1 230kV Ph 3 Cur, 0.424, 137.258 
Dgl 1 230kV Res  Cur, 0.017, 324.199 
 
Dgl 2 230kV 
---------------- 
Dgl 2 230kV Ph 1 Cur, 0.418, 257.373 
Dgl 2 230kV Ph 2 Cur, 0.408, 197.122 
Dgl 2 230kV Ph 3 Cur, 0.411, 137.104 
Dgl 2 230kV Res Cur, 0.017, 244.132 
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System Errors 
 
This section lists the system errors that may occur during the operation of the software.  For your 
convenience, they are arranged alphabetical. 

ASCII Driver 

The following errors are displayed if the system encounters an error while reading the contents of a file: 
 
1 Read Error: File Not Found - This error occurs if the system cannot access the file attributes, or the 

file does not exist on disk.  From the file table, click the Dir menu button to see if the file still exists on 
disk. 

2 Not Enough Memory to Read File, File Truncated - This error occurs if there is not enough memory to 
read the contents of the selected file.  Close other applications to free up memory. 

3 Read Error: File is Empty - This error occurs when the selected file is empty. 

Change Drive/Directory 

The following error message is displayed if the system encounters a problem while changing to a 
specified drive/directory: 
 
1 Destination Path Not Valid - This error occurs when the path entered inside the Change 

Drive/Directory dialog is not a valid path.  Press F7 or click the ChDir menu button to re-enter a valid 
path. 

COMTRADE Driver 

The following errors messages are displayed if the system encounters a problem while reading the 
contents of a COMTRADE File: 
 
1 Unable to Open the COMTRADE CFG file - This error occurs when the CFG file is not found in the 

active directory, or there was a problem opening the file.  The DAT and CFG files must reside in the 
same directory.  From the file table, click the Dir menu button to see if the CFG file still exists on disk. 

2 Not Enough Memory Available to Read the COMTRADE CFG file - This error occurs if there is not 
enough memory to read the contents of the CFG file.  Close other applications to free up memory. 

3 Not Enough Memory Available for the Device Information - This error occurs if there is not enough 
memory for the analog and digital channel information.  Close other applications to free up memory. 

4 Not Enough Memory Available to Read Device File - This error occurs if there is not enough memory 
to store the first data samples in the DAT file.  Close other applications to free up memory. 

5 Unable to Open the Selected Device File - This error occurs if the COMTRADE DAT file was not 
found in the active directory, or there was a problem opening the file.  The COMTRADE DAT and 
CFG files must reside in the same directory.  From the file table, click the Dir menu button to see if 
the DAT file still exists on disk. 

6 Not Enough Memory Available to Read the File, File Truncated - This error occurs if there is not 
enough memory available to store all the samples in the DAT file.  Close other applications to free up 
memory. 
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7 Not Enough Memory Available to Display Selected File - This error occurs if there is not enough 
memory to store the drawing variables.  Close other applications to free up memory. 

8 Too Many Acquisition Frequencies, File Truncated - This error occurs if the number of acquisition 
frequencies stored in the file exceeds 80. 

9 Invalid Acquisition Frequency - This error occurs if the system encounters an invalid acquisition 
frequency in the CFG file. 

Copy/Move Files 

The following error messages are displayed if the system encounters a problem while copying or moving 
a file: 
 
1 Getting the File Attribute's - This error occurs if the system cannot access the file’s attributes from the 

allocation table. 
2 Opening the Source File - This error occurs if the source file does not exist on disk. 
3 Creating the Destination File - This error occurs if the destination directory is full or the file attribute is 

set to read only. 
4 Reading from the Source File - This error occurs if there was a problem accessing the source file on 

disk, the disk sector, or the data maybe corrupt. 
5 Writing to the Destination File - This error occurs if there was a problem accessing the destination file, 

the disk sector, or the data maybe corrupt. 
6 Setting the Date & Time for the Destination File - When a file is copied the date and time of the 

destination file is changed to the data and time of the source file.  This error occurs if the software 
could not access the destination file. 

7 Cannot Find the Destination File - After a file is copied the software checks the destination path to 
see if the file was copied successfully.  This error occurs if the file was not found in the destination 
directory. 

8 Destination and Source do not Match - After a file is copied, the software compares the size of the 
source file to the size of the destination file.  This error occurs if the file sizes do not match. 

9 Insufficient Disk Space - This error occurs if there is not enough disk space on the destination drive to 
store the file. 

 
When an error occurs, the system prompts the user to continue or abort the copy process.  Press “Y” to 
continue or “N” to cancel the command. 

DXF Driver 

The following errors messages are displayed if the system encounters a problem while reading the 
contents of a DXF file: 
 
1 Not Enough Memory for DXF Variables - This error occurs if there is not enough memory to store the 

DXF variables.  Close other applications to free up memory. 
2 Could Not Open the Selected DXF File - This error occurs if the selected DXF file was not found, or 

there was a problem opening the file.  From the file table, click the Dir menu button to see if the file 
still exists on disk. 

3 Not Enough Memory for DXF Entities - This error occurs if there is not enough memory to store the 
first drawing items.  Close other applications to free up memory. 

4 Not Enough Memory to Read File, File Truncated - This error occurs if there is not enough memory to 
store all the drawing items.  Close other applications to free up memory. 

5 No Scale Factors Defined in the DXF File, Process Aborted - This error occurs if the DXF scale 
factors are not found in the file.  The scale factors are needed to correctly display the DXF drawing. 
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Hexadecimal Driver 

The following errors messages are displayed if the system encounters a problem while reading the 
contents of a Binary file: 
 
1 Read Error: File Not Found - This error occurs if the system cannot access the file attributes in the file 

allocation table, or the file does not exist on disk.  From the file table, click the Dir menu button to see 
if the file still exists on disk. 

2 Not Enough Memory to Read File, File Truncated - This error occurs if the system runs out of memory 
while reading the contents of the selected file.  Close other applications to free up memory. 

3 Read Error: File is Empty - This error occurs if the selected file is empty. 

Software Analog Channels 

The following errors messages are displayed if the SAC instruction formats are not adhered to.  The error 
message includes the corresponding channel number that caused the error.  Two types of errors can 
occur: 
 
1 Type Mismatch - This error occurs if the channel units do not match. 
2 Operation Error - This error occurs if the instruction format is incorrect.  For example the instruction 

terminator "/" is missing or the operator is invalid. 

Software Digital Channels 

The following errors messages are displayed if the SDC instruction formats are not adhered to.  The error 
message includes the corresponding channel number that caused the error. 
 

1 Operation Error - This error occurs if the instruction format is incorrect.  For example the instruction 
terminator "/" is missing or the operator is invalid. 
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System Keys 
 
This section lists the function keys, cursor keys, and menu buttons available in the file table, query fields, 
data display, port table, and DXF display. 

File Table 

Function Keys Description 

F1 Display the file table’s help file.  

F2 Display the file, at the cursor position in text format:  ASCII Editor. 

F3 Display the file, at the cursor position in hexadecimal format:  Hex Editor. 

F4 Display the list of station titles found in the active database directory. 

F5 Display the command line dialog to run an application. 

F7 Change the active path to the specified destination path. 

F8 Copy the marked files to the destination path. 

F9 Move the marked files to the destination path. 

F11 Display a table of sequence of events for all the marked waveform files. 

F12 Refresh the current directory 

 

Cursor Keys Description 

Left Arrow Move the cursor bar to the left one position. 

Right Arrow Move the cursor bar to the right one position. 

Up Arrow Move the cursor bar up one position. 

Down Arrow Move the cursor bar down one position. 

Page Up Display the files on the previous page. 

Page Down Display the files on the next page. 

Home  Move the cursor to the first column in the file table. 

End Move the cursor to the last column in the file table. 

Ctrl+Home Move the cursor to the first file in the file table. 

Ctrl+End Move the cursor to the last file in the file table. 

Tab Move the cursor from the file table to the query fields. 

Delete Delete all the marked files and empty directories. 

Enter Run the driver at the cursor position. 

Backspace Change the active path to the previous directory. 

Character keys Move to the next row in the active column that starts with the entered character. 

 

Menu Buttons Description 

 Folder Tree Show / Hide the Folder Tree 

 Email Email all marked files and their support files. 

 Refresh Refresh the current directory from disk. 

 ChDir Change the active path to the specified destination path. 

 Previous Dir Change to the previous directory. 
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 Last Dir Change to the last navigated directory. 

 Copy 
Copy the marked files to the destination path. 

 Move 
Move the marked files to the destination path. 

 Mark Mark/Unmark all visible files. 

 Query 
Query all files in the active directory. 

 Plot Plot the data contents for the highlighted file. 

 Summary 
Display the waveform summary for the file at the cursor position. 

 Edit Edit the contents of the file at the cursor position:  ASCII Editor 

Load Analysis 
Perform load analysis on the marked files. 

Query Fields   

Function Keys Description 

F1 Display the query help file.  

F5 Query all the marked files in the active directory.  

F6 Query all the files/directories in the active directory. 

F7 Query all the unmarked files in the active directory. 

F8 Clear the query criteria and set all the query operators to “=”. 

F9 Toggle through the available query operators for the active query field. 

 

Cursor Keys Description 

Up Arrow Return the cursor to the file table. 

Right Arrow Move the cursor one position to the right. 

Left Arrow Move the cursor one position to the left. 

Ctrl+Left Arrow Move the editor to the next query field. 

Ctrl+Right Arrow Move the editor to the previous query field. 

Tab Activate the Folder Tree. 

Enter Process the query criteria for all or marked files.  If a rename operator is used the 
marked files fault date and time is changed accordingly. 

 

Menu Button Description 

 Query Query all files in the active directory. 

Data Display 

Function Keys Description 

F1 Display the data help file.  

F2 Display the analog and digital channel information.  

F3 Generate a max/min peak chart and an EN/SR summary log. 

F4 Toggle between the available analog views. 

F5 Display the software analog channel dialog. 

F6 Turn channel amplitude auto scaling ON or OFF. 

F7 Turn super imposing ON/OFF for all or marked channels. 



Appendix C – System Keys 

C-3 

F8 Mark or unmark all the visible analog/digital channels. 

F9 Toggle between the available digital views (All or Triggered). 

F11 Display the harmonics table 

 

Cursor Keys Description 

Left Arrow Move the data bar to the left one sample. 

Right Arrow Move the data bar to the right on sample. 

Ctrl+Right Arrow Move the data bar to the next peak for the first display channel or the first 
marked channel. 

Ctrl+Left Arrow Move the data bar to the previous peak for the first display channel or the first 
marked channel. 

Shift+Ctrl+Right 
Arrow 

Move the data bar ahead one cycle for the first displayed channel or the first 
marked channel. 

Shift+Ctrl+Left Arrow Move the data bar back one cycle for the first displayed channel or the first 
marked channel. 

Shift+Left Arrow Shift the analog information table to the left by one column. 

Shift+Right Arrow Shift the analog information table to the right by one column. 

Page Up Page up through the channel data. 

Page Down Page down through the channel data. 

Home Move the data bar to the first data sample. 

End Move the data bar to the last data sample. 

Ctrl+Up Arrow Increase the amplitude for all or marked channels. 

Ctrl+Down Arrow Decrease the amplitude for all or marked channels. 

Ctrl+Page Up Expand the time scale for all visible channels. 

Ctrl+Page Down Condense the time scale for all visible channels. 

Tab Toggle between the analog and digital channels. 

Up Arrow Move the cursor up one channel. 

Down Arrow Move the cursor down one channel. 

Shift+Page Up Display the analog/digital channels on the previous page. 

Shift+Page Down Display the analog/digital channels on the next page. 

Ctrl+Home Display the first page of the analog/digital channels. 

Ctrl+End Display the last page of the analog/digital channels. 

Spacebar Mark or Unmark the channel at the cursor position. 

Shift+Up Arrow Mark or Unmark a group of channels while moving the cursor up. 

Shift+Down Arrow Mark or Unmark a group of channels while moving the cursor down. 

Insert Display the hidden channels that were removed by the delete keys. 

Delete Hide the marked channels and respace the unmarked channels. 

Enter Hide the unmarked channels and respace the marked channels. 

Esc Display all the hidden channels or exit the data window. 

Backspace Display all the hidden channels. 

+ Shift all the marked channels up one position. 

- Shift all the marked channels down one position. 

Ctrl-A Move the reference bar to the sample at the cursor bar. 

Ctrl-Z Move the RMS bar to the sample at the reference bar. 

 

Menu Buttons Description 
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 Reopen File Reopen a previous viewed waveform file. 

 Email Active File Email the active file and any support files needed. 

 View Raw Data 
View the waveform`s raw data file in an ASCII or binary editor. 

 Summary 
View the Analog/Digital Summary of the active displayed file. 

 Recorder Chans Display the waveform's analog/digital channel headers and scale factors. 

 Inc Magnify the amplitude of the marked channels. 

 Dec Attenuate the amplitude of the marked channels. 

 ASV 
Turn auto scaling ON/OFF for all visible channels. 

 In 
Condense the time scale of the visible channels. 

 Out 
Expand the time scale of the visible channels. 

 View Marked Hide the unmarked channels and respace the marked channels. 

 View All Replot all the hidden channels. 

  

 Set Ref Bar Move the reference bar to the sample at the cursor bar.  

 SetRMS Bar Move the RMS bar to the sample at the reference bar. 

 Properties 
Display the Window Properties dialog. 

 Restore Original 
Restores the samples to the original raw samples stored in the file. 

 Change Freq. 
Change the frequency of the active display file. 

 Duplicate Cyc. 
Duplicate the cycle and number of times at the data bar. 

 Resize Sliding 
Window 

Resize the RMS sliding window. 

DXF Display 

Function Keys Description 

F1 Display DXF mode's help window.  

F2 Display the Set Constants dialog.  

 

Cursor Keys Description 

Up Arrow Move the viewing area of the drawing up 40 pixels.  

Down Arrow Move the viewing area of the drawing down 40 pixels. 

Right Arrow Move the viewing area of the drawing to the right 40 pixels. 

Left Arrow Move the viewing area of the drawing to the left 40 pixels. 

Ctrl+Right Move the viewing area of the drawing to the right by one screen. 

Ctrl+Left Move the viewing area of the drawing to the left by one screen. 

Page Up Move the viewing area of the drawing up by one screen. 

Page Down Move the viewing area of the drawing down by one screen. 

Home Display the far left portion of the drawing. 

End Display the far right portion of the drawing. 

Ctrl+Home Display the top portion of the drawing. 

Ctrl+End Display the bottom portion of the drawing. 
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Tab Move to the next DXF drawing tab 

Shift+Tab Move to the previous DXF drawing tab 

+ key Increase the drawing's resolution using the zoom scaler constant. 

- key Decrease the drawing's resolution using the zoom scaler constant. 

 

Menu Buttons Description 

 Original  Display the drawing in the original coordinates.  

 Fit in Win Fit the full drawing to fit in the screen area. 

 Zoom-In 
Increase the drawing's resolution using the zoom scaler constant. 

 Zoom-Out 
Decrease the drawing's resolution using the zoom scaler constant. 

 Print Drawing Print the drawing displayed in the active tab. 

 Const Set the property Constants for the drawing. 

 Open File Open a DXF file and add it to the window. (Table DXF display) 

 Close File Close the selected DXF file. (Table DXF display) 
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A P P E N D I X  D  
 

Abbreviations & Symbols 
 
The abbreviations and symbols used by the system are listed below in alphabetical order. 
 

Symbol Descripition 

* Query criteria wild character. 

+ Query = Add to operator. 
SAC = Add analog channels operator. 
SDC = “OR” digital channels operator. 

- Query = Subtract from operator. 

-> Query = Replace with operator. 

. SDC = “AND” digital channels operator. 

/ SAC/SDC instruction termination indicator. 

< Query = Less than operator. 
SAC = Undertrigger operator. 

= Query = Equal to query operator. 

<CR> Enter key. 

> Query = Greater than operator. 
SAC = Overtrigger operator 

? Query criteria wild character. 

a SAC = Absolute envelope operator. 

A Analog channel unit, Amp. 
Digital channel state, Alarm. 

ASV Auto Scale Value. 

CH Channel’s display ID. 

DAU Data Acquisition Unit. 

DC Digital Channels. 

DXF Drawing Exchange Format. 

e SAC = Half cycle envelope operator. 

EN Events. 

Fst Summary = The first state of a digital channel. 

HP-Dif. Summary = ((absolute value of the HPeak-Up – absolute value of the HPeak-Dn)/OneBit) 

HPeak-Dn Summary = The highest negative peak value. 

HPeak-Up Summary = The highest positive peak value. 

ID The event file’s device ID number. 

k Kilo. 

Kbyte The size in kilobytes. 

LP-Dif. Summary = ((absolute value of the LPeak-Up – absolute value of the LPeak-Dn)/OneBit) 

LPeak-Dn Summary = The lowest negative peak value. 

LPeak-Up Summary = The lowest positive peak value. 

Lst Summary = The last state of a digital channel. 

N Digital channel state, Normal. 

OneBit Summary = An analog channel’s full scale value divided by the channel’s resolution. 

pU Summary = The prefix and unit of the analog channel. 

RMS Root Mean Square. 

SAC Software Analog Channels. 

SDC Software Digital Channels. 

SR Sensors. 
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Symbol Descripition 

V Voltage. 
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